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1
Product Symbols

This product uses a variety of symbols; refer to the following table for a list of these
symbols and their definitions.

Name and Definition (if required)Symbol

Caution
This symbol indicates a mandatory action to
take in order to avoid damage to these areas.

Warning
This symbol alerts users to areas where there
is the possibility of personal injury.

Hot Warning
This symbol alerts users to areas where there
are heated surfaces which should not be
touched.

Laser Warning
This symbol indicates a laser is being used and
alerts the user to refer to the appropriate safety
information.

Pinch Hazard
This warning symbol alerts users to areaswhere
there is the possibility of personal injury.

Lock

Unlock
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Name and Definition (if required)Symbol

Do Not Touch

Do Not Touch the Drum Cartridge
To avoid damage, do not touch the surface of
the Drum Cartridge.

DoNot Dispose into anOpen Flame / Inciner-
ate

Do Not Incinerate the Toner Cartridge
Always refer to the recycling instructions for
your region / marketplace for correct disposal
information and procedures.

Do Not Incinerate the Toner Waste Bottle
Always refer to the recycling instructions for
your region / marketplace for correct disposal
information and procedures.

Do Not Incinerate the Drum Cartridge
Always refer to the recycling instructions for
your region / marketplace for correct disposal
information and procedures.

Do Not Incinerate the Second Bias Transfer
Roll
Always refer to the recycling instructions for
your region / marketplace for correct disposal
information and procedures.

Flicker Label / 100 Amp Current
This symbol indicates usage only in premises
that have a service current capacity equal to or
greater than 100 Amps per phase.

Ground / Common / Earth Terminal

LAN
Local Area Network

USB
Universal Serial Bus
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Name and Definition (if required)Symbol

Keep Area Clear
Do not store any objects in this location.

Keep Area Clear
Do not store any objects in this location.

Keep Area Clear
Do not store any objects in this location.

DoNotUse Transparencieswith aWhite Strip
/ Overhead Projector Sheets with a White
Strip

Do Not Use Open Envelopes

Do Not Use Folded, Creased, Curled, or
Wrinkled Paper

Do Not Use Ink Jet Paper

Tray Guides Must Touch Media

Load Postcards in the Indicated Direction
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Name and Definition (if required)Symbol

Load Hole-punched Paper as Indicated

On
This symbol indicates the main power switch is
in the ON position.

Off
This symbol indicates the main power switch is
in the OFF position.

Standby
This symbol indicates the secondary power
switch is in the Standby position.

Do Not Dispose in Normal Household Waste
Stream

• Application of this symbol is confirmation
that you should not dispose of items, such
as Customer Replaceable Units (CRUs), in
the normal household waste stream. You
must dispose of these items in compliance
with agreed national procedures.

• This symbol often accompanies batteries
and indicates that used electrical and elec-
tronic products and batteries should not be
mixed with general household waste.

• For more information about collection and
recycling, please contact your localmunicip-
ality, your waste disposal service, or the
point of sale where you purchased the
items.
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2
Getting Started

The Xerox® Versant® 3100 Press is a full color / black and white, auto-duplex press that
operates at a speed of 100 prints perminute (when printing on 8.5 x 11 inch / A4 paper).

The system configuration consists of the Advanced High Capacity Feeder (Trays 6 and
7), the print engine with internal feeding trays (Trays 1-3), and an embedded Control
Panel and touch screen (the user interface). A print server is also part of the configuration,
which includes the Stock Library Manager application used for stock and tray setup
and print job submission. An Offset Catch Tray may be connected to the press, or other
optional inline finishing devices are available.

Note
With the exception of the Offset Catch Tray, all other finishing devices require the
Interface Decurler Module.

The press includes the 4 dry ink / toner and drum cartridges, transfer belt and fuser /
ROS system, Full Width Array calibration feature, decurler, registration and paper path,
and paper inverter.

Print Server Overview
The print server networked with your press accepts, processes, and manages document
files for job submission to the press.

One of two print servers may be used with your press:

• Xerox® FreeFlow® Print Server
• Xerox® EX Print Server, Powered by Fiery®

The print server contains the Stock Library Manager application. Refer to the Stock
Library Manager > Help for information on how to set up stocks, custom profiles, and
paper trays used by the press.

Note
For detailed information on your specific print server, refer to the customer
documentation that was delivered with it.
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Press Components

6.1. Right Front DoorAdvancedHigh Capacity Feeder (Trays
6 and 7) 7. Center Front Door

2. Dry Ink / Toner Cover 8. Left Front Door
3. Control Panel and Touch Screen 9. Paper Trays 1, 2, and 3
4. Power On / Off Button
5. Offset Catch Tray (OCT)

Internal Components

5.1. Dry Ink / Toner Waste BottleDry Ink / Toner Cartridges
2. 6.Main Power Switch Fuser Module

7.3. Transfer ModuleCircuit Breaker Switch (on rear of press)
4. Paper Cooling Module

Locating the Press Serial Number

The press serial number can be accessed fromeither the press control panel or by locating
the serial number plate on the inside frame of the first feeder tray (Tray 1).
1. Press theMachine Status button on the press control panel.
2. From the Machine Status screen, ensure that theMachine Information tab is

displayed.
The press serial number is displayed under General Information.
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3. If there is a loss of power and it is not possible to access theMachine Status screen,
the press serial number can also be found on the inside frame of the press near paper
Tray 1:
a) At the press, fully open paper Tray 1.
b) At the left of the feeder tray, on the press frame, locate the plate with the serial

number (SER#).

Advanced High Capacity Feeder (Trays 6 and 7)
Tip
The Advanced High Capacity Feeder is part of the standard press configuration.

The Advanced High Capacity Feeder contains Trays 6 and 7. These trays feed a variety
of stock sizes, including standard, heavyweight, and large-sized stocks up to 13 x 19.2
in. / 330 x 488 mm in size and weighing between 52 gsm and 350 gsm. Each tray holds
2,000 sheets of coated and uncoated stock.

Note
The Advanced High Capacity Feeder (Trays 6 and 7) may or may not include optional
Tray 5 (Bypass).

The following illustrations show the Trays 6 and 7 with and without the optional Tray
5 (Bypass).

Trays 6 and 7 with
the optional Tray 5

Trays 6 and 7 without
the optional Tray 5
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Trays 6/7 Components

4.1. Tray 6Paper Jam / Error Indicator Panel
2. 5.Paper Level Indicators Tray 7

6.3. Circuit Breaker SwitchFeeder Front Cover

Control Panel

The embedded Control Panel on the press includes an LCD touch screen, keypad and
feature buttons. The touch screen displays instructions, faults, and informational
messages. Select the Control Panel buttons to log in, perform job setup functions, and
view job, press, and supply statuses.

DescriptionNameItem
Number

Displays the main menu. Provides access to view the sup-
plies and trays available on the press and the status of
consumables.

Home button1

Displays the Tools mode screen. For the operator, select
the Tools icon to view billing information and to perform
press calibration such as Full Width Array color uniformity
adjustments.

Tools button2

Use to check the progress of active jobs and detailed in-
formation about completed jobs or pending jobs. This area
also allows you to delete a job (cancel printing) and to
pause jobs.

Job Status button3
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DescriptionNameItem
Number

Use to check the press configuration, the software version,
the press billing meter and counter information, and to
access and print job history or error reports.

Machine Statusbutton4

Directly touch the screen to select and set features. Dis-
plays instructional and informational messages, fault
clearance procedures and general press information.

Touch Screen5

Use to log in and out of Administrator mode or Authentic-
ation mode with user ID and password.

Log In / Out button6

Use to select a different language for the touch screen
options.

Language button7

Use this button if the press has been inactive and the touch
screen is dark (system is in Energy Savermode). This button
manually exits the system fromEnergy Savermode; it does
not place the press in Energy Save mode.

Power Saver button8

Use to enter alphanumeric characters. The ‘C’ Cancel Entry
cancels the previous entry made on the numeric keypad.

Numeric Keypad9

Use this button to cancel the previous entry made on the
numeric keypad.

Cancel Entry button10

Use this button to return all selections to the same state
as when the press was powered on. Press once to clear a
current entry. Press twice to return to default settings.

Clear All button11

Press to stop and pause the print job in progress.Stop button12

Press to start and print a selected report. Also used by the
Customer Service Engineer during diagnostic routine pro-
cedures.

Start button13

The three indicator lights that identify: data transmission
in progress, the press is experiencing an error, and main
power is on.

Press Status Lights14
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Status Lights

There are three status lights on the press directly below the Control Panel. From right
to left, they are:

DescriptionNameItem
Number

This is a steady green light indicating the main power to
the system is on.

Main Power Status LED1

This is a steady orange light indicating the press is experi-
encing faults and / or errors.

Error Status LED2

This is a flashing green light indicating that the transmis-
sion of an incoming print job is in process.

Data Transmission
Status LED

3
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Logon

There are two logon levels:

• Guest / Operator: This is the default logon user. You are automatically logged on as
Guest.

• Administrator: This logon level is required to customize the system and network
defaults for your press and to customize particular print jobs by setting, or changing
parameters for certain features. Press the Guest button (or the Log in button on the
Control Panel) to access the Login screen.

Note
Refer to the System Administration Guide for more information on the Administrator
features.

Language
Note
The number of languages available on your systemdepends onwhatwas installed during
the initial installation process.

Selecting a particular Language button immediately changes the language. No
confirmation is required.

Changing the Language
1. Press the Language button on the press Control Panel.

The Language window displays on the touch screen.
2. Select the desired language from the list and select Save.

The language on the screen changes to the new language and closes the Language
window.

3. Select the Cancel button to return to the main screen.
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Full System Configuration
Note
Full system configurations will vary depending on which optional devices are attached
to the press. For detailed information on optional devices, refer to the Optional Devices
Guide for Xerox® Versant® 3100 Press.

The following illustration shows an example of a full system configuration with optional
devices attached; this is only one example.

6.1. High Capacity Stacker*Dual Advanced High Capacity Feeder
(Trays 8 and 9)* 7. Two-sided Trimmer*

2. AdvancedHigh Capacity Feeder (Trays
6 and 7)

8. C/Z Folder*
9. Production Ready (PR) Booklet Maker

Finisher*3. Color Press
4. Interface Decurler Module (IDM)* 10. SquareFold® Trimmer*
5. Inserter*

* Numbers 1 and 4-10 indicate optional devices.

Power On / Off

Power Switches

There are three power switches involved with the press:

• Circuit Breaker Switch
• Main Power Switch
• Power On / Off Button

Important
Always use the Power On / Off button first, and then power off the Main Power Switch.
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Circuit Breaker Switch

The Circuit Breaker Switch located at the rear of the press. Initially check to make sure
this switch is set to On when the press is shipped.

Main Power Switch

The Main Power Switch located inside the Center Front Door.

Note
Switching off the Main Power also shuts off the Main Power Status LED.

Tip
Before switching off the press, ensure that it is not in Power Saver Mode.

This switch is used mainly by the Xerox Service Representative when servicing the press.
In rare troubleshooting situations, you may be directed to power off the press with this
switch.

Power On / Off Button

The Power On / Off Button is located on the right side of the Control Panel. Use this
button to power ON or OFF the press.
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Power On / Off the Press
1. To switch on the press, check that the Main Power switch behind the Center Front

Door is On.
2. Press the Power On / Off button on top of the press to the ON position.

The Ready Indicator light displays green.
A screenmessage advises of a short wait while the fuser warms up and the press runs
a system check. You can set features for a job during this time and the printing process
will start automatically when the press is ready.

3. To switch off, press the Power On / Off button to the Off position.

Note
Allow the press to remain off for a minimum of 10 seconds before switching on the
power again.

Power Saver Mode

The Power Saver feature allows the press to enter a reduced power consumption mode
when all print jobs have completed and there are no jobs currently processing. There
are two power saving modes: Low Power and Sleep.

• Low Power: After remaining inactive for a preset time period, the press enters the
Low Power mode.

• Sleep: After entering Low Power mode and remaining inactive for another preset
time period, the press enters the Sleep mode.

By default, the press automatically enters the Low Power mode after 1 minute of
inactivity. After 1 minute of inactivity, the press then enters Sleep mode. These time
intervals for both modes can be changed by the system administrator.

Refer to the following example:

• Low Power Mode is set to 1 minute.
• Sleep Mode is set to 10 minutes.
• Sleep Mode activates after 10 minutes of total inactivity and not 10 minutes after

the Low Power Mode begins.
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Low Power Mode

In this mode, the power to the Control Panel and fuser unit is lowered to save power.
The display goes out and the Power Saver button on the Control Panel lights.

To exit the Low Power Mode, press the Power Saver button. The Power Saver button is
no longer lit, indicating that the Power Saver feature is canceled.

Sleep Mode

In this mode, the power is lowered more than in the Low Power mode. The display goes
out and the Power Saver button on the Control Panel lights.

To exit the Sleep Mode, press the Power Saver button. The Power Saver button is no
longer lit, indicating that the Power Saver feature is canceled.

Exiting Power Saver Mode

The press exits Power Saver mode either by pressing the Power Saver button on the
Control Panel or when receiving print data from an incoming job.

Getting Help

Help on the Xerox Web Site

For technical product support, Xerox supplies, customer documentation, and answers to
frequently-asked questions, go towww.xerox.com. Youwill find the latest documentation
and the knowledge base under Support & Drivers. Use the Contact link for specific
contact information / telephone numbers in your area.

Note
Be sure to periodically check this website for the latest information on your product.

It may be helpful to know your press serial number before calling for support. The press
serial number is shown on the Machine Information tab:Machine Status > Machine
Information.

Stock Library Manager Online Help

At the top of the print server window contains a Help area from which you can locate
information on how to use the print server’s job and print management features.

There is also Help fromwithin the Stock LibraryManager application on the print server.
Use this Online Help to learn how to manage stocks used by the press and to select
advanced settings that resolve paper curl, offsetting, paper misfeeds, registration and
fold adjustments.
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From the Stock Library Manager window, select Help from the top left of the screen. An
Aboutmenu and Helpmenu are available:

• Select the Aboutmenu to learn the software version installed.
• Select the Helpmenu to access all of the Stock Library Help topics such as Tray

Properties, Stock information, how to add stock, and more.

In the Contents area, topics are displayed to the right of the book icons. Selecting a
book icon expands the view and provides selections to subtopics. The right and left arrow
buttons advance forward or backward one topic at a time using the same order as
displayed on the Contents tab.

Customer Diagnostic Tool

A Customer Diagnostic Tool CD is provided with your system. It provides you with the
information needed to identify and resolve image quality issues or faults the press may
be experiencing, and includes the procedures on how to replace customer-accessible
press components.

This tool is the first step you can use in isolating a problem or specific fault code and
the resolution associated with it.

Print Server Customer Documentation
• The FreeFlow Print Server features are documented in the Online Help system from

the Helpmenu shown on the main print server window. Additional FreeFlow Print
Server user documentation can be found at www.xerox.com.

• The EX Print Server Help menu on the Command WorkStation window is designed
to provide information on specific work flowswhen using theCommandWorkStation.
Additional user documentation supplied by EFI Fiery is available to you from
www.xerox.com under the Support and Drivers link for your press.
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3
Print Job Submission

Information to Know Before Printing a
Job
Basic Job Workflow

The basic workflow for setting up a job and submitting it from the print server is:

1. Within the Stock Library Manager on the print server, set up and define the stock
properties for the paper you will use and assign that paper to the feeder tray.

2. At the press, load the appropriate paper to be used for the job that matches the
tray property settings.

3. At the print server main window, customize your job such as inserting special pages
and tabs, and create your print queue that defines the attributes of those jobs sent
to the queue.

4. Submit the job file from the print server to the networked press for printing.

Stock Library Manager

Begin your job workflow at the Stock Library Manager. The Stock Library Manager is a
separate application residing on the print server desktop only and not at the press. At
the Stock Library Manager main window, set up and manage the stock types, profiles
associated with a stock, the Stock Library and RML, and the feeder tray attributes to use
when printing a job.

Note
For complete information on the Stock LibraryManager and on how to set up your stock
and paper tray settings for the print job, refer to the Online Help in the Stock Library
Manager.
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Enable Paper Tray Features

At the press, the System Administrator can enable the Auto Tray Switching feature and
prioritize the trays to switch over to using when one tray with the same paper becomes
empty.

Define Jobs and Queues

Refer to the Print Server documentation to learn about programming various types of
jobs including tab jobs and assembling different stock types from different trays for the
same job.

How to Submit a Print Job
There are a variety of ways to submit your job for printing:

• From your computer workstation (PC or Mac), using print drivers such as PostScript
and Printer Command Language (PCL), you can submit a document file to the print
server queue. From the print server, you would then submit the job to the press.

Note
Make sure the appropriate print drivers have been installed on your computer. Refer
to your print driver documentation or the Xerox web site for more information on
how to download or install print drivers.

• At any remote workstation, using a Hot Folders application to submit the document
file to the print server.

• At the print server, importing/adding a document file to a print queue. Manage the
job settings of the document and then submit to the press for printing.

Refer to the Stock Library Manager application’s Online Help on how to set up the
properties for a job that you submit from the print server.

Printing from Your Computer
The system supports either Xerox FreeFlow or Fiery EX print drivers. Through print drivers
installed on your computer or Mac, you can send a document file from your desktop to
the print server, which can then be submitted to the press for printing.

Note
You can also use a drag and drop Hot Folders feature by which to send your files to the
print server for printing to the press.

1. From your computer, select the file you want to print and open it in its application.
2. Select File > Print.
3. Select the desired print server queue.
4. Select the Properties button for the queue.
5. Select the desired output options such as quantity or 1 sided / 2 sided printing.
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6. Select OK to close the Properties window.
7. Select Print to send the job to the print server queue.

Printing from the FreeFlow Print Server
From your computer, you can submit your document files (select Print) to a directory on
the print server through the use of installed print drivers. You could also copy the
document files onto a USB flash drive or CD/DVD and then connect those devices to the
print server for importing.
1. If you copied the file onto a storage device, connect your device to the print server

and from the top menu bar select Services > Print From File.
2. From the Print From File window, select the Files tab and Browse.
3. From Look In, locate your storage device or other network directory containing the

document files you want.
4. Select and highlight one of the document files. Select OK.
5. From the Queue field at the top right of the Print From File window, select the desired

print queue.
6. Using the other tabs on the screen, select the desired output options such as quantity

or 1- or 2-sided printing.
7. Select Print.

The job is sent to the desired queue and either held or immediately printed.

8. Select Close.

Printing from the EX Print Server
From your computer, you can submit your document files (select Print) to a directory
on the print server through the use of installed print drivers. You could also copy the
document files onto a USB flash drive or CD/DVD and then connect those devices to the
print server for importing.
1. If you copied the file onto a storage device, connect your device to the print server

and select Services > Print From File.
2. From the EX Print Server, select File > Import Job.
3. Select Add.
4. Locate your storage device or other directory containing the document files.
5. Select and highlight one of the document files. Select Open.
6. Select Import.
7. Select the desired queue such as Process and Hold or Print and Hold.

The job is sent to the selected queue or to the press for immediate printing.
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Information about Printing on Tabs
Before printing a job with tabs, read the following information:

• You can set up your job to insert preprinted tabs into your document.
• Use one tray for the body pages, another tray for the preprinted tab stock, and

another tray for cover or back pages.
• While you can print tab stock from any of the paper trays on the system (Trays 1, 2,

3, 5, 6, 7, 8, or 9), the recommendation is to use Trays 6, 7, 8, or 9 for best results.
• If you plan to apply staple or punch finishing, use Trays 5, 6, 7, 8, or 9 only.
• Loading orientation depends on what tray you are using.
• Refer to Paper and Media for information and instructions on how to load and align

tab stock in the trays.

Print Server Information about Programming a Job with Tabs

There aremany types of tab stock and tab sequences available. Precut tabs are commonly
used and have two different orientations: the single straight collated tab stock or the
single reverse collated tab stock.

When programming tab jobs and loading tab stock, consider the following:

• Precut tabs can only print 1-sided
• There are specific job settings that you need to define such as tab order / sequence,

number of bank sets, stock weight, paper size, and insertion before or after body
pages. Refer to your print server documentation formore detailed setting information.

• Always load tab stock LEF into the tray where the straight edge of the stock is the
lead edge and the tabs are oriented at the trail edge.

• Always use a complete set or bank or tabs in the paper tray.
• If staple or punch finishing, use trays 5, 6, 7, 8, 9, or T1 (Inserter).
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Printing Tabs from the Print Server
1. From the print server, create and define the Tab stock for the paper tray you will be

using.
2. Load the Tab stock in Trays 1, 2, 3, 5, 6, 7, 8, 9, or T1 (optional Inserter). Refer to

Paper and Media chapter.
3. From the print server window, access the Held queue that contains your document.

Select the document you want to configure with tabs. Double click to open the file’s
properties.

4. Once all settings are made, select Print.
The press prints the complete set of tabs with the body pages defined. Any extra
tabs not used in the job are sent to the output tray.

3-5Xerox® Versant® 3100 Press
User Guide

Print Job Submission



Xerox® Versant® 3100 Press3-6
User Guide

Print Job Submission



4
Job / Machine Status

Job Status
The Job Status feature allows the user to check active, pending, and completed jobs.
The ability to cancel printing or pause jobs is also available from Job Status.

Job Status Area

The Job Status button on the press control panel displays the progress and status of any
currently printing jobs and lists all completed jobs.

Select the Active Jobs tab to view the status of currently pending or in-progress print
jobs on the system.

1.

Select the Completed Jobs tab to view a list of all jobs that have printed successfully.2.

Select the Group Parent Jobs checkbox to list and display the jobs according to a par-
ent/child relationship hierarchy.

3.

Active Jobs Tab
1. Press the Job Status button on the control panel.
2. Select the Active Jobs tab.
3. From the displayed list, select the applicable job to view.

Use the up or down buttons to navigate the list.
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4. If required, select Display Time to show the time required to process the job.
5. To delete a job or change the execution order, select a job from the list.
6. Select Delete or Promote from the pop-up menu.

• Delete: This option cancels the current or pending job.
• Promote: This option moves a job to the top of list and runs it after the job that

is currently printing / copying.
• Details: This option shows the details of the selected document.
• Close Menu: This option closes the pop-up menu.

Completed Jobs Tab
1. Press the Job Status button on the Control Panel.
2. Select the Completed Jobs tab.

A list of the completed or deleted jobs display. Use the scroll bar to navigate the list.
3. To check the details of a job, select the job from the displayed list.
4. From this Status window, select one of the following to print a history of this job.

a) To print the job details, select Print this Job Report button.
b) To print the history of parent / child jobs, select Print this Job History button.

5. After checking the job details, select Close.

Machine Status
Press theMachine Status button on the Control Panel to access the Machine Status
information, including press configuration, faults, billing information, maintenance, and
reporting features.

Machine Information Tab

This tab provides general information about the press such as the currently installed
software version and the press serial number. This area also allows you to print reports
and view details that apply to billing impressions.

5.1. Software VersionMachine Serial Number
2. 6.Current System Software Print Reports

7.3. Maintenance AssistantIP Address and Host Name
4. 8.Machine Configuration Overwrite Hard Disk
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Machine Serial Number

TheMachine Serial Number is displayed in the General Information area on theMachine
Information tab. Use this number when calling Xerox for technical information or
assistance.

Current System Software

The version of the system software that is currently installed on the press is displayed
under the Current System Software title.

IP Address and Host Name

This is the unique Internet Protocol (IP) address and host name that identifies the press
to the specific network to which it is connected.

Machine Configuration

Select theMachine Configuration button to display a list of the various hardware
components and options that are available on the press as well as their status. Hardware
components and options include any optional feeding and finishing devices attached
to the press.

Software Version

Select the Software Version button to display a list of the software versions for the
various system components, including any optional feeding and finishing devices.

Print Reports

This Print Reports button is enabled by the system administrator. From the various
reports available, select a report on the touch screen and then select the Start button
to print. Some reports are only available in the system administrator mode. From the
Print Reports screen, select the desired report to print.

Job Status

From the Job Status screen, select the desired history report to print.

• Job History Report: This report lists the status, attributes, input source and output
destination of every print job completed, deleted or shutdown.

• Error History Report: This report lists the most recent errors and faults that occurred
on the press.

Printer Reports

From thePrinter Reports screen, selectConfiguration Report. TheConfiguration Report
lists the hardware configuration, devices and software installed, and the network settings
on the system such as port and proxy settings. Print and place this report near the press
for easy access to information such as the press serial number.
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Job Counter Report

The Job Counter Report is available only when from the system administrator mode.
This report identifies the total number ofminutes the press has been in various operating
modes, the billing counters for various size impressions printed from each tray, and a
summary of the number of jobs printed with various page counts.

Auditron Report / Meter Report

The Auditron Report / Meter Report is available only when from the system
administrator mode.

Note
This Auditron Report / Meter Report is not applicable to a print-only system.

Maintenance Assistant

Select theMaintenance Assistant button to send the Xerox Remote Print Services
diagnostic information on the press to Xerox Support.

Overwrite Hard Disk

The Overwrite Hard Disk feature is a standard data security function on the system. It
prevents the document image and registered data that is recorded on the press hard
disk from being illegally retrieved or removed.

Job image data stored on the hard disk within the press can be deleted and overwritten
after a number of overwrites or a period of time specified by the system administrator.
The Standby status indicates the completion of the overwriting process.

Faults Tab

The Faults tab provides a list of faults that occurred on the press. Access this tab by
pressing theMachine Status button on the control panel and then selecting the Faults
tab.

The Faults tab displays the following information about faults that occurred on the
press:

1. Fault Code: This column identifies the code number assigned to the fault message.
2. Date and Time: These columns indicate the day and time the fault occurred.
3. Image Count: This column indicates the total number of printed impressions.
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Note

Billing Information Tab

Accessing Billing Information

To view billing impressions and counters (or meters) information recorded by the press,
access the Machine Status area of the press Control Panel.
1. Press theMachine Status button on the Control Panel.
2. Select the Billing Information tab.

The Billing Information screen displays.

3. To view the Billing Impression Mode, press the Tools button on the Control Panel,
select the Tools icon, and select Setup > Billing Impression Mode.

Billing Impressions Information

The Billing Information screen allows you to view the total number of impressions (prints)
recorded by the press, including a category of the number of color prints only, black
prints only and large media prints. It also displays specific usage counter information.
The counters display the impression amount for all printed jobs.

All meters thatmay be used for billing purposes are displayed on the Billing Information
screen:

• Color Printed Impressions: This value (number) represents the total number of color
impressions that have been printed.

• Black Printed Impressions: This value (number) represents the total number of
black-only impressions that have been printed.

• Total Impressions: This value (number) represents the total number of ALL
impressions. It is the sum of the Color Impressions and the Black Impressions.

• Color Large Impressions: This value (number) represents the total number of large
color impressions. These impressions are one side of one sheet of large media (for
example 11 x17 in. / A3). Large Impressions are any prints that are larger than 145
sq. in./935 sq. cm.

Note
This meter / counter is NOT added to the Total Impressions meter/counter since it is
already added to the Color Impressions meter / counter.

• Black Large Impressions: This value (number) represents the total number of large,
black-only impressions. These impressions are one side of one sheet of large media
(for example 11 x17 in. / A3). Large Impressions are any prints that are larger than
145 sq. in. / 935 sq. cm.

Note
This meter / counter is NOT added to the Total Impressions meter/counter since it is
already added to the Black Impressions meter / counter.
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Billing Impression Mode

The Billing ImpressionMode defines how the press tracks and records impressionsmade
on large-size paper such as A3 or tabloid. The type of Billing Impression Mode used by
your press is set during system installation. A Xerox Sales Representative can confirm
the Billing Impression Mode applicable for your press.

There are two types of Impression Modes:

• A3 ImpressionMode - For allmedia sizes (including large-sized), counts all impressions
equally.

• A4 Impression Mode - Counts large impressions on media such as A3 and 11 x 17
inches (media that is larger than 8.5 x 14 inches), as their A4 equivalent.

To view the current Billing Impression Mode in effect on the press:

• Press the Tools button on the Control Panel, select the Tools icon, and select Setup >
Billing Impression Mode.

Usage Counters

Select theUsage Counters button to view even more detail on billing and counts being
tracked on the press such as the number of 1-sided vs 2-sided print jobs.

From the Counters drop-down list you can select the desired counter to view:

• Impression Counters
• Sheet Counters
• All Usage Counters

Impression Counters

This view displays the total impression amount. In other words, impression is the image
on one side of one sheet of media. This counter shows the total impression amount
for color and black-only impressions.

• Total Impressions: This number represents the total number of impressions for all
color and black-only print jobs.

• Black Impressions: This number represents the total number of impressions for all
black/white print jobs.

• Black Large Impressions: These impressions are one side of one sheet of a large
black-only document (such as 11 x17 in. / A3). Large Impressions are any prints that
are larger than 8.5 x14 in. / B4.

• Color Impressions: This number represents the total number of impressions for all
color print jobs.

• Color Large Impressions: These impressions are one side of one sheet of a large color
document (such as 11 x17 in. / A3). Large Impressions are any prints that are larger
than 8.5 x14 in. / B4.
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Sheet Counters

This counter provides information on the total number of sheets the press feeds to the
output area. Each sheet counts as one click on the counter (regardless of size or whether
it is a one-sided or two-sided print job).

All Usage Counters

This view provides a complete total of all the counters, including the totals from the
Impression Counters and Sheet Counters.

Update Button

Select this button to refresh and update the counts.
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5
Paper and Media

Paper and Media Overview
Before loading paper, consider the following:

• To define attributes for a stock, to add a new stock to the Stock Library, or to assign
a stock to a paper tray for the print job, access the Stock Library Manager on the
print server. If you have restricted access, contact your System Administrator.

Note
The Stock LibraryManager is an application that is loaded onto the print server and
is used to manage the stocks and paper trays for your press.

- By default, the Stock Library feature is available to both the operator and system
administrator modes.

- Your System Administrator may restrict user access to change or add stocks.
- When you are loading paper, the Stock Library Manager application opens the

Tray Properties window for that tray and you can view or change the stock
assigned to that tray.

• The press supports the ability to pull different stock sizes and paper types from various
trays and assemble them as part of a single job. To select multiple paper trays and
insert different papers within one job, program this custom job at the print server
using features such as special pages.

• The press supports Automatic Tray Switching, which allows a job to switch
automatically from an empty tray to a full tray containing the same size paper,
orientation and stock type. Refer to the SystemAdministration Guide for information
on how to enable this feature and prioritize the order of trays to search on and use.
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General Paper Loading Guidelines
• Fan paper before loading it in the paper tray.
• Do not overfill the paper trays. Do not load paper above the indicated maximum fill

line in the tray.
• Adjust the paper guides to fit the paper size.
• If excessive jams occur, use paper or other approved media from a new package.
• Do not print on label media after a label has been removed from a sheet.
• Use only paper envelopes.
• Print envelopes 1-sided only.

Unsupported Media

Some paper and othermedia types can cause poor output quality, increased paper jams,
or damage the press. Do not use the following:

• Rough or porous paper
• Inkjet paper
• Paper that is business-card size
• Paper that is folded or wrinkled
• Paper that is curled more than 0.47 in. / 12 mm
• Paper with cutouts or perforations
• Stapled paper
• Damp paper
• Thermal or heat-transfer paper
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips
• Padded envelopes

Note
In addition to the above list, there may be other media that is not recommended or
supported. For details, please contact your local Xerox representative.
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Paper / Media Storage Guidelines

Storing paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage
from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs,
is particularly damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.
• Maintain constant temperatures and relative humidity.
• Avoid storing paper in locations that are damp or collect moisture.
• Store paper flat, either on pallets, cartons, shelves, or in cabinets.
• Avoid food or drinks in the area where paper is stored or handled.
• Do not open sealed packages of paper until you are ready to load the paper into the

trays. Leave stored paper in the original packaging. The paper wrapper protects the
paper from moisture loss or gain.

• Some specialmedia is packaged inside resealable plastic bags. Store themedia inside
the bag until you are ready to use it. Keep unused media in the bag and reseal it for
protection.

Supported Paper

Paper Size Ranges

Maximum SizeMinimum SizeTray

13 x 19.2 in. / 330.2 x 488 mm5.51 x 7.17 in. / 140 x 182 mmTrays 1, 2, and 3

13 x 19.2 in. / 330.2 x 488 mm3.86 x 5.75 in. / 98 x 146 mmTray 5 (Bypass)

13 x 19.2 in. / 330.2 x 488 mm3.86 x 5.75 in. / 98 x 146 mmTrays 6 and 7
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Paper Specifications for All Trays
Note
Always refer to the RecommendedMedia List (RML) for a comprehensive list of supported
media. The RML can be accessed from the Stock Library Manager application, and can
also be downloaded from http://www.xerox.com/.

Weight (gsm)TraysFeed Direc-
tion (LEF /
SEF*)

Paper SizePaper Type

All TraysPlain paper
Coated and un-
coated

• Trays 1,2,
and 3: 52
to 256

•• SEF / LEFB5
• •A4 SEF / LEF

•• SEF / LEFA4 Cover
Hole-punched paper
Coated and un-
coated)

• Trays 5, 6
and 7: 52
to 350

•• SEFB4
• •A3 SEF

•• SEFSRA3

64 to 105All TraysRecycled paper
(coated and un-
coated)

•• SEF / LEF7.25 x 10.5 in.
• •8 x 10 in. SEF / LEF

•• SEF8.46 x 12.4 in.

All TraysEmbossed
(coated and un-
coated)

•• SEF / LEF8.5 x 11 in.
• Trays 1, 2,

and 3: 106
to 256

•• SEF / LEF8.5 x 13 in.
•• SEF8.5 x 14 in.

• •9 x 11 in. SEF / LEF
• Trays 5, 6

and 7: 106
to 350

•• SEF11 x 15 in.
• •11 x 17 in. SEF

•• SEF12 x 18 in.
• •12.6 x 19.2 in. SEF

•• SEF13 x 18 in.
• •16-kai (TFX) SEF / LEF

•• SEF / LEF16-kai (GCO)
• •Pa-kai (TFX) SEF

•• SEFPa-kai (GCO)

—All TraysLEF8.5 x 11 in. (A4)Transparency

106 to 350Trays 5 (By-
pass), 6, and 7

SEF4 x 6 in.
A6

Postcard (coatedand
uncoated)

—All TraysSEF / LEF8.5 x 13 in.
215.9 x 330.2 mm

Government-Legal

—All TraysSEF / LEF8.90 x 12.20 in.
226.0 x 310.0 mm

Double-Thick (DT)
Special A4

—All TraysSEF12.20 x 17.00 in.
310.0 x 432.0 mm

Double-Thick (DT)
Special A3
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Weight (gsm)TraysFeed Direc-
tion (LEF /
SEF*)

Paper SizePaper Type

—Trays 5 (By-
pass), 6, and 7

Envelopes
•• SEFMonarch: 3.875 x 7.5

in. • SEF
• #10: 4.125 x 9.5 in. • SEF / LEF
• C4: 229 x 324 mm • SEF / LEF
• C5: 162 x 229 mm

All TraysLEF8.5 x 11 in. / A4Labels (coated and
uncoated) • Trays 1, 2,

and 3: 106
to 256

• Trays 5, 6
and 7: 106
to 350

163All TraysLEF9 x 11 in.Tabs and Dividers

LEF = Long Edge Feed; SEF = Short Edge Feed

Paper Tray Information

Paper Tray Information for Trays 1, 2, and 3

Trays 1, 2, and 3 are identical. When the press is first installed, the tray size setting for
Trays 1 and 3 are set at 8.5 x 11 inches or A4 (LEF). The tray size setting for Tray 2 is set
at 11 x 17 inches or A3 (SEF).

Note
Each feeder tray has a stock loading label. When loading media into the tray, refer to
the labels on the inside panel of the feeder tray for the correct orientation of that stock
type.

When the Stock Library Manager is installed on the print server, the default for all trays
is Letter (8.5 x 11 inches). At the Stock Library Manager, the operator can change those
default tray sizes different stock size settings.

Note
The sizes selected from the Stock Library Manager for all trays must match the paper
sizes that are loaded in the trays.

The specifications for each tray are:

• Maximum of 550 sheets of 24 lb. (90 gsm) uncoated paper; 28-80 lb. cover (105-120
gsm) coated stock

• Paper weight range of 18 lb. Bond to 95 lb. Cover (64 gsm to 256 gsm)
• Paper sizes starting at 5.51 x 7.17 in. / 140 x 182 mm to a maximum of 13 x 19.2 in.

/ 330.2 x 488 mm
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• Stock types include transparencies, heavyweight, coated and uncoated, hole-punched,
and tabs

• Loading paper Long Edge Feed (LEF) / portrait or Short Edge Feed (SEF) / landscape
(dependent on the actual paper size)

• Auto size detection capability
• Automatically adjusts the tray position in the front and back based on the paper size;

this is done once the tray is closed

Paper Tray Information for Trays 6 and 7
Note
Each feeder tray has a stock loading label. When loading media into the tray, refer to
the labels on the inside panel of the feeder tray for the correct orientation of that stock
type.

The specifications for each tray are:

• Maximumof 2,000 sheets of 24 lb. (90 gsm) uncoated paper; 2,100 sheets of 82 gsm
and 2,300 sheets of 64 gsm

• Paper weight range of 52 to 350 gsm
• Stock types include transparencies, heavyweight, coated and uncoated, hole-punched,

and tabs

Tip
Transparencies perform best when printed from Trays 6 and 7.

• It is recommended that you use Tray 5 (Bypass) to feed envelopes. However, Trays
6 and 7 may also be used for feeding envelopes.

- If you use Trays 6 or 7, envelopes must be fed either with the Postcard Bracket
or the optional Envelope Support Kit installed.

- If the Postcard Bracket is used, the stack height is limited to 200 envelopes.

Postcard Bracket

The postcard bracket is delivered with Trays 6 and 7 from manufacturing. The postcard
bracket allows you to print on smaller size media without requiring post-processing
cutting or sorting. The postcard bracket accommodates 4 x 6 in. (101.6 x 152.4 mm)
SEF media and smaller. For more information, refer to Paper Size Ranges.

Note
For more information, refer to Postcards.

Optional Envelope Support Kit

The Envelope Support Kit enables a greater quantity of envelopes to be loaded and
printed from Trays 6 or 7. This optional kit consists of two plastic pieces that fit into the
bottom of the tray and a postcard bracket that attaches to the side of the tray. The
plastic pieces lift one side of the stack of envelopes to offset the extra thickness of the
flaps. This keeps the stack level for feeding and enables more envelopes to be fed from
the tray.
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Note
For more information, refer to Envelopes.

Paper Tray Information for Tray 5 (Bypass)
Note
Depending on system configuration, optional Tray 5 (Bypass) is located on the top of
either Trays 6/7 or optional Trays 8/9).

This tray is used primarily when using a small quantity and special media (such as
envelopes). When using the Tray 5 (Bypass), refer to the following information:

• Maximum of 250 sheets of 24 lb. (90 gsm) uncoated paper; 28 lb. to 110 lb. cover
(106-300 gsm) coated stock

• Paper weight range of 52 gsm (uncoated) to 300 gsm (coated)
• Stock types include transparencies, heavyweight, coated and uncoated, hole-punched,

and tabs
• Program the stock job properties at the Stock Library Manager on the print server.
• Do not load mixed-size paper into the bypass tray.
• Do not load materials above theMAX line as indicated on the tray.
• It is recommended that you use Tray 5 (Bypass) to feed envelopes.

Press Productivity Information

The following tables show the maximum print speed of the press across the full range
of paper sizes that the press supports. Unless otherwise noted, the print speed is identical
for full-color or black-and-white-only prints.

Process and print speed is based on 1-Sided / 2-Sided mode, paper type, paper weight,
paper size, and feeding tray.

Note
The references to Bond andCoverweight ranges are approximations based on conversion
to the nearest standard paper weight and type.
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Productivity Information for Trays 1, 2, 3, 6, and 7
Note
Media heavier than 256 gsm (90 lb. Cover) cannot be fed from Trays 1–3.

Prints Per Minute (ppm)Paper TypePaper WeightPaper Feed
Direction

Paper Size

2-Sided1-Sided

50100Uncoated and
coated

52 – 300 gsm
18 lb. Bond –
110 lb. Cover

LEF8.5 x 11 in. /
A4

4080SEF8.5 x 11 in. /
A4

3060SEF8.5 x 14 in. /
B4

2552SEF11 x 17 in. /
A3

2547SEF12 x 18 in. /
SRA3

2447SEF13 x 19.2 in. /
330.2 x 488
mm

4080Uncoated and
coated

301 – 350 gsm
110 lb. Cover –
130 lb. Cover

LEF8.5 x 11 in. /
A4

3264SEF8.5 x 11 in. /
A4

2651SEF8.5 x 14 in. /
B4

2244SEF11 x 17 in. /
A3

2039SEF12 x 18 in. /
SRA3

203913 x 19.2 in. /
330.2 x 488
mm
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Prints Per Minute (ppm)Paper TypePaper WeightPaper Feed
Direction

Paper Size

2-Sided1-Sided

–40Labels and
Transparencies

106 – 300 gsmLEF8.5 x 11 in. /
A4

–32SEF8.5 x 11 in. /
A4

–25SEF8.5 x 14 in. /
B4

–22SEF11 x 17 in. /
A3

–19SEF12 x 18 in. /
SRA3

–32Tab Stock106 – 176 gsmLEF8.5 x 11 in. /
A4

–23Tab Stock177 – 256 gsmLEF8.5 x 11 in. /
A4

16Tab Stock257 – 300 gsmLEF8.5 x 11 in. /
A4
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Productivity Information for Tray 5 (Bypass)

Prints Per Minute (ppm)Paper TypePaper WeightPaper Feed
Direction

Paper Size

2-Sided1-Sided

3570Uncoated and
coated

52 – 300 gsm
18 lb. Bond –
110 lb. Cover

LEF8.5 x 11 in. /
A4

3059SEF8.5 x 11 in. /
A4

2550SEF8.5 x 14 in. /
B4

2244SEF11 x 17 in. /
A3

2141SEF12 x 18 in. /
SRA3

2040SEF13 x 19.2 in. /
330.2 x 488
mm

3570Uncoated and
coated

301 – 350 gsm
110 lb. Cover –
130 lb. Cover

LEF8.5 x 11 in. /
A4

2957SEF8.5 x 11 in. /
A4

2447SEF8.5 x 14 in. /
B4

2040SEF11 x 17 in. /
A3

1937SEF12 x 18 in. /
SRA3

183613 x 19.2 in. /
330.2 x 488
mm
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Loading Paper

Loading Paper in Trays 1, 2, and 3

From the Stock Library Manager on the print server, set the stock type, weight and size
settings for the tray. At the press, check that the stock loaded in the paper tray matches
the paper tray attributes programmed.

Note
A paper jam may occur if a tray is opened while it is being used to feed stock.

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Extend the paper guides outward until they stop.

6. Load and align the edge of the paper against the left edge of the tray.

Paper can be loaded either in the LEF / portrait or SEF / landscape direction.

7. Adjust the paper guides by pressing in the guide releases and carefully moving the
guides until they lightly touch the edges of the material in the tray.
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Note
Do not load materials above theMAX line located on the guides.

8. Gently push in the tray until it comes to a stop.
The paper Tray Properties window displays on the print server (on Stock Library
Manager). You can view and set stock attributes and verify trays are assigned with
the correct stock. The Stock Library Manager is available from the print server only
and not at the press.

9. From the Tray Properties window, enter or verify the correct paper information,
including size, type, weight and, if necessary, paper curl and / or alignment option.
Select the stock and assign the stock to the tray to be used.

10. Select OK to save the information and close the Tray Properties window.

Loading Paper in the Trays 6 and 7
1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Extend the paper guides outward until they stop.
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6. Load and align the edge of the paper against the right edge of the tray.

Paper can be loaded either in the LEF / portrait or SEF / landscape direction.

7. Adjust the paper guides by pressing in the guide releases and carefully moving the
guides until they lightly touch the edges of the material in the tray.

Note
Do not load materials above theMAX line located on the guides.

8. Gently push in the tray until it comes to a stop.
The paper Tray Properties window displays on the print server (on Stock Library
Manager). You can view and set stock attributes and verify trays are assigned with
the correct stock. The Stock Library Manager is available from the print server only
and not at the press.

9. From the Tray Properties window, enter or verify the correct paper information,
including size, type, weight and, if necessary, paper curl and / or alignment option.
Select the stock and assign the stock to the tray to be used.

10. Select OK to save the information and close the Tray Properties window.

Loading Paper in Tray 5 (Bypass)
1. Slide the paper guides outward to the desired paper size.

2. Select the appropriate paper stock for your print job.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Insert the paper or media into the tray until it stops.
6. Adjust the paper guides so that they touch the edges of the stack.
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The paper Tray Properties window displays on the Stock Library Manager on the
print server. The Stock Library Manager is not available at the press.

Note
Do not load materials above theMAX line located on the guides.

7. From the Tray Properties window, verify that the correct paper information such as
size, type and weight are selected and match the stock loaded in the tray.

8. Select OK to save the information and close the Tray Properties window.

Matching the Tray and Stock Information
Important
To ensure maximum productivity and successful job completion, always verify that the
Tray Properties information (from the Stock LibraryManager on the print server)matches
the actual stock / media that is loaded in the tray being used for the print job.

Before running a print job, check for any of the following conditions:

• Modifications were made to the Stock Library, such as

- Adding a stock,
- Copying a stock,
- Creating a new stock,
- Editing an existing stock

• Stock / media was loaded into the selected tray for the print job
• The tray selected for the print job was opened / closed

Note
If any of these conditions apply, verify that the Tray Properties information matches
the actual tray contents.

If the stock loaded in the tray does not match the information on the Tray Properties
window, then a message may be displayed in one or more of the following ways:

• On the User Interface of the press
• On the Stock Library Manager application (on the print server)
• On the print server
• On both the Stock Library Manager and the print server
• On the Stock LibraryManager, the print server, and possibly on the pressUser Interface
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Tip
Stock / traymismatch information and how it is displayed is dependent on the individual
print server. If stock is changed in a tray, a message may not be displayed; therefore it
is important to always perform the following steps before running a print job.

1. Check for a tray mismatch message on the press User Interface. If a mismatch
message is displayed, select it.
A new message displays and explains what media is required and the tray location.

2. Go the print server and check the main / home window for a similar message:

• If a message exists, follow the information provided on the print server to correct
the stock mismatch issue, and continue to the next step.

• If a message does not exist, continue to the next step.

3. Load the stock in the tray.
If theUser Interface on the press displays amismatchmessage, follow the instructions
provided to load the correct stock.

4. Change the Tray Properties to match the contents of the tray; this is done from the
Stock Library Manager on the print server.
a) Verify the paper size, type (coated, uncoated), and weight of the paper loaded

in the tray.
b) If necessary, enter that information on the Tray Properties window.

5. Ensure that the tray is closed.
6. Ensure that all tray / stock mismatch messages have been resolved.
7. Start your print job.

Paper Feed Performance in Trays 6 and
7
If misregistration / skew occurs on printed output that was fed from Trays 6 or 7, manual
adjustment of the paper-feed levers may improve and correct the printed output.

Important
For most print jobs, these levers should remain in their default position. The position of
these levers should be changed only if there is a skew problem when running a specific
print job and / or media type. Changing the levers may causemore skew problems when
running certain media types such as coated, label, tab stock, hole-punched paper,
transparency, film, postcards, and envelopes.

The paper-feed adjustment levers are found in Trays 6 and 7. These levers are used to
improve paper feed accuracy and to reduce paper skew problems.
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2.1. Right-side Paper-feed Adjustment
Lever

Rear Paper-feed Adjustment Lever

Improving Paper Feed Performance in Trays 6 and 7
1. Open the tray by pulling it out slowly until it stops.

2. Ensure that the desired paper is loaded into the tray.
3. Go to the Stock Library Manager on the print server.

a) From the Tray Properties window, verify the correct paper information including
size, type, weight, and paper curl or alignment option for the tray.

b) Select OK and close the Tray Properties window.

4. On the tray, slide the rear paper-feed adjustment lever to the right.

5. Close the tray by slowly pushing it in until it comes to a stop.
6. Run your print job.
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7. After the print job finishes, open the tray and return the rear paper-feed adjustment
lever to its default position by sliding it to the left.

Leave the tray open, and continue to the next step.

8. Retrieve and evaluate the printed output; choose one of the following:

• The paper is fed accurately without skew and the printed output is satisfactory.
Close the tray and your task is completed.

• The paper is skewed and the printed output is unsatisfactory; proceed to the next
step.

9. Adjust the right-side paper-feed lever:
a) On the tray, slide the right-side paper-feed adjustment lever toward the rear of

the tray.

b) Close the tray and verify the tray settings from the Stock Library Manager on
the print server.

c) Run your print job.

10. Retrieve and evaluate the printed output; choose one of the following:

• The paper is fed accurately without skew and the printed output is satisfactory;
perform the following:

1. Open the tray.
2. Return the right-side paper-feed adjustment lever to its default position

by sliding it toward the front of the tray.
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3. Close the tray and your task is completed.

• The paper is skewed and the printed output is unsatisfactory; proceed to the next
step.

11. Adjust both levers:
a) Open the tray and slide the rear paper-feed adjustment lever to the right.

b) Ensure that the right-side paper-feed adjustment lever still is in the rear position.

c) Close the tray and verify the tray settings from the Stock Library Manager on
the print server.

d) Run your print job.

12. After the print job finishes, open the tray and return both levers to their default
positions:
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a) Return the rear paper-feed adjustment lever to its default position by sliding it
to the left.

b) Return the right-side paper-feed adjustment lever to its default position by sliding
it toward the front of the tray.

c) Close the tray, and continue to the next step.

13. Retrieve and evaluate the printed output; choose one of the following:

• The paper is fed accurately without skew and the printed output is satisfactory;
your task is completed.

• The paper is skewed and the printed output is unsatisfactory; continue to the next
step.

14. If you are still having skew adjustment problems, refer to theAdvanced Stock Setup
information on the Stock Library Manager on the print server. If necessary, perform
one of the following:

• Create / use an Alignment Profile to resolve the problem.
• Adjust the Aligner Roll Pressure to resolve the problem.
• Adjust the Regi-Loop to resolve the problem.

If the problem continues, contact the Customer Support Center.

Important
If using an Advanced Stock Setup feature, always return the feature to its default
setting before using the press.
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Printing on Special Media

Transparencies

Guidelines for Printing on Transparencies

Always refer to the following guidelines before using transparencies:

• For optimum system performance and image projection, use Xerox removable stripe
transparency materials. These premium transparencies are specifically designed to
provide optimum print quality.

• Use of other transparencies may cause machine damage and result in excessive
service calls.

• Transparencies can be printed from all trays.
• Use only transparency stock listed in the Recommended Media List (RML).
• Do not intermix paper with individual transparencies in a tray. Jams may occur.
• Do not load more than 100 transparencies in a paper tray at one time.
• Load 8.5 x 11 in. (A4) transparencies long edge feed only (portrait).
• Fan the transparencies to stop them from sticking together before loading.
• Load transparencies on top of a small stack of same-size paper.
• At the Stock Library Manager, make sure to select Transparency as the Paper or

Media Type and select the tray containing the transparencies as the Paper Source.
• The maximum output stack height should not exceed 100 transparencies.

Xerox® Versant® 3100 Press5-20
User Guide

Paper and Media



Loading Transparencies in Trays 1, 2, and 3

Load the transparencies in the LEF (portrait) direction and align the edge of the
transparencies against the left edge of the tray, with the side to be printed on facing
up.

Loading Transparencies in Trays 6 and 7

Load the transparencies in the LEF (portrait) direction and align the edge of the
transparencies against the right edge of the tray, with the side to be printed on facing
up.

Loading Transparencies in Tray 5 (Bypass)

Load the transparencies in the LEF (portrait) direction and align the edge of the
transparencies against the right edge of the tray, with the side to be printed on facing
up.

5-21Xerox® Versant® 3100 Press
User Guide

Paper and Media



Hole-punched Paper

Guidelines for Printing on Hole-punched Paper

Hole-punched paper is defined as having two or more holes along one edge for use in
ring binders and notebooks.

Always refer to the following guidelines before using hole-punched paper:

• Paper with punched holes can be printed from all trays.
• Hole-punched paper can be loaded either in the LEF / portrait or SEF / landscape

direction.
• Position the holes along the feed edge, as shown on the image on the front of the

tray.
• Load hole-punched paper with the side to be printed on facing up.
• To prevent jams or damage, make sure that any plugs (pieces cut out of the paper

to create the holes) do not remain in the stack.

Loading Hole-punched Paper in Trays 1, 2, and 3

Load and align the edge of the hole-punched paper with the holes against the left edge
of the tray.
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Loading Hole-punched Paper in Trays 6 and 7

Long-edge (LEF) Feed Direction

Load and align the paper against the right side of the tray for LEF direction.

Short-edge (SEF) Feed Direction

Load and align the paper against the right side of the tray for SEF direction.

Loading Hole-punched Paper in Tray 5 (Bypass)

Load and align the edge of the hole-punched paper with the holes against the right
edge of the tray.
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Tab Stock
Guidelines for Printing on Tab Stock

Always refer to the following guidelines before using tab stock:

• Tab Stock can be printed from all trays.
• Tabs are loaded in the tray only in the long-edge feed (LEF) direction.
• Tab stock is loaded so the straight edge of the stock is in the feed direction.
• You can load either single straight collated or single reverse collated tab stock.
• Refer to the print server documentation for more detailed information on how to set

up a tab job at your print server.
• If a jam occurs while running tabbed sets, cancel the job and start again.
• Before loading tab stock in a tray, programyour tab job at the Stock LibraryManager

application on the print server or from your print driver:

- Select Tab Stock or Precut Tabs as the Paper Type.
- Select the tray containing the stock as the Paper Source.
- Select the correct Paper Weight for the tabs, usually 163 gsm. The weight range

may be 106 to 176 gsm.
- Set Modules to the number of tabs in the set.
- For the stock size, set a Custom Size of 9 x 11 inches (229 x 279 mm) LEF.
- For the Print Output Order / Tab Sequence, select N to 1.
- For Output Delivery, select Face Up.
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Loading Tab Stock in Trays 1, 2, and 3

Load the tab stock LEF (portrait) and align the straight edge of the tab stock against
the left edge of the tray and with the side to be printed on facing down.

Loading Straight Collated Tabs

Load straight collated tabs with the first blank tab cutout toward the rear of the tray.

Loading Reverse Collated Tabs

Load reverse collated tabs with the first blank tab cutout toward the front of the tray.
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Loading Tab Stock in Trays 6 and 7

Load the tab stock LEF, with the side to be printed on facing down; align the straight
edge of the tab stock against the right edge of the tray and the tabs to the left.

Loading Straight Collated Tabs

Load straight collated tabs with the first blank tab cutout toward the front of the tray.

Loading Reverse Collated Tabs

Load reverse collated tabs with the first blank tab cutout toward the rear of the tray.
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Loading Tab Stock in Tray 5 (Bypass)

Load the tab stock LEF, with the side to be printed on facing up; align the straight edge
of the tab stock against the right edge of the tray and the tabs to the left.

Loading Straight Collated Tabs

Load straight collated tabs with the first blank tab cutout toward the front of the tray.

Loading Reverse Collated Tabs

Load reverse collated tabs with the first blank tab cutout toward the rear of the tray.
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Labels

Guidelines for Printing on Labels

Always refer to the following guidelines before using labels:

• Labels can be printed from all trays.
• When submitting your print file, select Labels as the Paper Type, and select the tray

containing the labels as the Paper Source.
• Use labels designed for laser printing.
• Follow these weight guidelines:

- Trays 1, 2, and 3 can hold a maximum of 256 gsm
- Tray 5 (Bypass) can hold a maximum of 300 gsm
- Trays 6 and 7 can hold a maximum of 350 gsm

• Do not use vinyl labels or dry gum labels.
• Only print on one side of the sheet of labels.
• Do not use any sheet where labels are missing as it may damage the press.
• Store unused labels flat in their original packaging.
• Leave the label sheets inside the original packaging until ready to use.
• Return any unused sheets of labels to their original packaging and reseal.
• Do not store labels in extremely dry, humid, hot or cold conditions.
• Rotate stock frequently.
• Long periods of storage in extreme conditions can cause labels to curl and jam in the

press.

Loading Labels in All Trays

Refer to the following when loading labels in the paper trays.

• Load labels in Trays 1, 2 and 3 with the labels face down.
• Load labels in Trays 5 (Bypass), 6 and 7 with the labels face up.
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Glossy Paper

Guidelines for Printing on Glossy Paper

Glossy Paper is a type of coated paper that can be printed from all trays.

Always refer to the following guidelines before using glossy paper:

• Select Coated as the Paper Type, and select the tray containing the glossy paper as
the Paper Source.

• Select the correct Paper Weight and Size.
• Do not open sealed packages of glossy paper until you are ready to load them into

the press.
• Store glossy paper flat in the original packaging.
• Remove all other paper from the tray before loading glossy paper.
• Load only the amount of glossy paper you plan to use, and remove the unused portion

from the tray when you are finished printing.
• Replace the unused portion in the original wrapper and seal for later use.
• Rotate stock frequently.
• Long periods of storage in extreme conditions can cause glossy paper to curl and jam

in the press.

Postcards

Guidelines for Printing on Postcards

Always refer to the following guidelines before using postcard stock:

Tip
When printing postcards in Trays 6 or 7, the Postcard Bracket is required. Always install
the postcard bracket before loading and printing postcards from these trays.

• Postcards may be printed from Trays 5, 6 and 7.
• Do not open sealed packages of postcard stock until you are ready to load them into

the press.
• Store postcard stock flat in the original packaging.
• Remove all other paper from the tray before loading postcard stock.
• Load only the amount of postcard stock you plan to use, and remove the unused

portion from the tray when you are finished printing.
• Replace the unused portion in the original wrapper and seal for later use.
• If using Trays 6 or 7, always remove and store the Postcard Bracket when you are

finished printing.
• Rotate the postcard stock frequently.
• Long periods of storage in extreme conditions can cause postcard stock to jam in the

press.
• When submitting your print file, from either the Stock Library Manager or from your

print driver, select the following options:
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Select Custom Paper as the Paper Type, and enter the Size dimensions of the
postcard.

-

- Enter the Paper Weight for the postcard stock.
- Select the tray (Tray 5, 6 or 7) as the Paper Source.

Supported Postcard Sizes

Feed DirectionPostcard Size

Short Edge Feed (SEF)4 x 6 in. / 101.6 x 152.4 mm

Short Edge Feed (SEF)A6 / 148 x 105 mm
(5.8 x 4.1 in.)

Loading Postcards in Trays 6 and 7
Note
Install the postcard bracket before printing postcards.

1. Slowly open one of the paper trays until it stops and remove the paper.

2. Move the paper guides out to their largest position.

3. To remove the postcard bracket, loosen the screw on the left side of the tray ( )
and remove the bracket ( ).
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4. Install the postcard bracket:

a) Sit the bracket on the locating pins on the upper frame and in the grooves on
the bottom of the tray.

b) Tighten the thumb screw so it locks the postcard bracket in place.

5. Load the postcard stock SEF and against the right side of the tray.

6. Adjust the paper guides against the stock.

7. Close the paper tray and confirm the new settings at the print server.
8. Run your print job.
9. Upon completion of your print job, remove the postcard stock and the postcard

bracket from the tray.
10. Store the postcard bracket by inserting it into the storage area on the left side of the

tray ( ) and tightening the screw ( ).

Loading Postcards in Tray 5 (Bypass)

Load postcards SEF, with the side to be printed on facing up.
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Envelopes

Guidelines for Printing on Envelopes
• The recommended tray for printing envelopes is Tray 5 (Bypass).
• Envelopes also may be printed from Trays 6 or 7. Before printing envelopes from

Trays 6 or 7, one the following must be installed:

- The Postcard Bracket
- The optional Envelope Support Kit

• If using Trays 6 or 7 and the Postcard Bracket is mounted, the envelope stack height
is limited to a maximum of 100 envelopes. Capacity may vary based on envelope
type and manufacturer.

• Use only supported envelope sizes, and load them in the recommended feed direction.
For more information, refer to Supported Envelope Sizes.

• Use of other size envelopes may be used, but performance is not guaranteed.
• Envelopes must be run 1-sided only.
• Recommended capacity is 30-40 envelopes. Capacity may vary based on envelope

type and manufacturer.
• Always load envelopes with the flaps closed and flaps face down.
• When loading SEF, place the flaps facing the front of the press.
• When loading LEF, place the flaps facing the lead edge (feed direction into the press).
• When submitting your print file, select a custom paper as the Paper Type, and enter

the dimensions of the envelope.

- The width is measured from the lead edge to the trail edge of the envelope.
- This means that if you are loading the envelope SEF, enter the long dimension

of the envelope as the width.
- If you are loading the envelope LEF, enter the short dimension of the envelope

as the width.

• Enter a heavy weight for the media, such as 176 gsm or greater for 24lb envelopes.
Best results will vary based on envelope type and manufacturer.

• Select the Tray 5 (Bypass) as the Paper Source.
• Do not use padded envelopes. Use envelopes that lie flat on a surface.
• Store unused envelopes in their original packaging to avoid the excess moisture or

dryness which can affect print quality and cause wrinkling. Excessive moisture can
cause the envelopes to seal before or during printing.

• Some wrinkling or embossing may occur when printing on envelopes. Successful
envelope printing depends on the quality and construction of the envelopes. Try
another envelope brand if problems occur.
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• Greater image registration variance may be experienced on envelopes.
• Maintain constant temperatures and relative humidity.
• Removal of the envelopes from the output top tray is recommended to minimize

poor stack quality and possible jams.
• Printed envelopes are sent only to the Offset Catch Tray (OCT) or to the top tray of

the standard finishers.

Supported Envelope Sizes

Feed DirectionHeight x Width DimensionsEnvelope Size

SEF3.875 x 7.5 in.Monarch

SEF4.125 x 9.5 in.#10

SEF / LEF229 x 324 mmC4

SEF / LEF162 x 229 mmC5

Loading Envelopes in Trays 6 and 7 with the Postcard Bracket
Note
Install the postcard bracket before printing envelopes.

1. Slowly open one of the paper trays until it stops and remove the paper.

2. Move the paper guides out to their largest position.
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3. To remove the postcard bracket, loosen the screw on the left side of the tray ( )
and remove the bracket ( ).

4. Install the postcard bracket:

a) Sit the bracket on the locating pins on the upper frame and in the grooves on
the bottom of the tray.

b) Tighten the thumb screw so it locks the postcard bracket in place.

5. Load the envelope either in the short-edge-feed (SEF) or long-edge-feed (LEF) direction:

• When loading envelopes SEF, ensure the flaps are closed and face down, and
postion the flaps along the front of the tray.

• When loading envelopes LEF, ensure the flaps are closed and face down, and
postion the flaps along the right of the tray.
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6. Adjust the paper guides against the stock.

7. Close the paper tray and confirm the new settings at the print server.
8. Run your print job.
9. Upon completion of your print job, remove the remaining envelopes and the postcard

bracket from the tray.
10. Store the postcard bracket by inserting it into the storage area on the left side of the

tray ( ) and tightening the screw ( ).

11. Store the remaining envelopes in their original packaging.

Loading Envelopes in Trays 6 and 7with the Optional Envelope Support
Kit
Note
If available, use the optional Envelope Support Kit to feed and print envelopes from
Trays 6 or 7.

The Envelope Support Kit enables a greater quantity of envelopes to be loaded and
printed from the tray.
1. Slowly open one of the paper trays until it stops and remove the paper.
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2. Move the paper guides out to their largest position.

3. Locate the Envelope Support Kit.
4. Install the L-shape envelope bracket:

a) Sit the bracket on the locating pins on the upper frame and in the grooves on
the bottom of the tray.

b) Tighten the thumb screw so it locks the L-shape envelope bracket in place.

5. Locate the larger of the plastic pieces and place it in the bottom of the tray so that
it fits around the ends of the inboard paper guide.

6. Locate the shorter plastic piece install it in the tray:

a) Place the shorter plastic piece in the bottom of the tray so that it fits along the
right side of the tray and into the corner, to the right of the envelope bracket
that you installed.

b) Place the magnet at the end of the piece into the corner of the tray and facing
down.
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The raised portion of the piece at the other end should be facing up, and on top
of the cork pad on the tray bottom.

7. Load the envelopes SEF on top of the plastic inserts, with the flaps closed and facing
down.

Note
The flaps should always be down and positioned along the front of the tray.

8. Adjust the paper guides against the stock.

9. Close the paper tray and confirm the new settings at the print server.
10. Run your print job.
11. Upon completion of your print job, remove the envelope stock and the envelope

supply kit components from the tray.
12. Place the envelope supply kit components into storage.
13. Store the remaining envelopes in their original packaging.

Loading Envelopes in Tray 5 (Bypass)

Load envelopes in Tray 5 in either the short edge feed (SEF) or long edge feed (LEF)
direction.

Loading Envelopes in Tray 5 in the SEF Direction

When loading envelopes SEF, ensure the flaps are closed and face down, and postion
the flaps along the front of the tray.
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Loading Envelopes in Tray 5 in the LEF Direction

When loading envelopes LEF, ensure the flaps are closed and face down, and postion
the flaps along the right of the tray.

Loading Media in Optional Devices

Loading Media in the Optional Dual Advanced High Capacity
Feeder (Trays 8 and 9)

Refer to the Optional Devices Guide for Xerox® Versant® 3100 Press for specific
information on this device.

Loading Post-Process Media in the Optional Inserter

Refer to the Optional Devices Guide for Xerox® Versant® 3100 Press for specific
information on this device.

Loading Post-Process Media in Optional GBC AdvancedPunch Pro

For loading tabs into the GBC AdvancedPunch, refer to the guide on the customer
documentation CD that came with the device, or go to www.xerox.com for more
information.
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6
Maintenance

General Precautions and Warnings

Warning
Precision components and high-voltage power supplies are used on the press:

• Never open or remove covers that are screwed shut unless specifically instructed in
the User Guide.

• A high-voltage component can cause electric shocks.
• Whenopening the panels and covers that are screwed shut to install or detach optional

accessories, be sure to follow instructions in the User Guide.
• Do not try to alter the press configuration or modify any parts; doing so might cause

press malfunction or fire.

Caution

• Do not place the equipment where people may step or trip on the power cord.
• Do not place objects on the power cord.
• Do not override or disable electrical or mechanical interlocks.
• Do not obstruct the ventilation openings. These openings prevent overheating of the

equipment.
• Never push objects of any kind into slots or openings on this equipment. Making a

contact with a voltage point or shorting out a part may result in fire or electrical
shock.

• Use the materials and supplies specifically designed for your equipment. The use of
unsuitable materials may result in poor performance of the equipment and possibly
a hazardous situation.

• Follow all warnings and instructions that are marked on or supplied with the
equpiment.

• Do not block or cover the slots and openings on the equipment.
• Do not attempt to override any electrical or mechanical interlock devices.
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Cleaning the Press
Read and adhere to the following information when cleaning the press:

• Before you start to clean the press, be sure to switch off the power using the circuit
breaker switch and unplug the press.

Warning
Cleaning the press without switching off the power may cause an electric shock.

• Always use a dry lint-free cloth for all cleaning actions unless otherwise directed.

Caution
Do not use benzene, paint thinner, other volatile liquids, or spray insect repellent on
the press as doing so may discolor, deform, or crack covers.

• If a moistened cloth is used, wipe afterwards with a dry lint-free cloth.

Caution
Cleaning the press with an excessive amount of water may cause the press to
malfunction and/or damage documents during printing.

Cleaning the Exterior
1. Wipe the exterior with a soft clothmoistened with water. If dirt is difficult to remove,

try gentlywipingwith a soft clothmoistenedwith a small amount of neutral detergent.

2. Wipe off any excess water from the exterior with a soft cloth.

Clean Fuser Assembly Information

Run the Clean Fuser Assembly routine from the Toolsmenu when you encounter an
image quality issue caused by contaminants in the fuser. For example, use this feature
when you see dry ink / toner debris on the back side of prints.

The press automatically runs this routine periodically, but if you see image quality
problems with dry ink / toner on the back of prints, you can initiate this procedure
manually in order to resolve the issue.
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Clean Fuser Assembly Methods

The Clean Fuser Assembly feature provides two methods for running the routine:

• Clean with Paper: This method runs blank sheets through the press to remove any
residual dry ink / toner from the fuser. The “Clean with Paper” method may be used
any press operator, and does not require administrator login.

• Clean with Felt: This method uses felt that is equipped inside the press to remove
any dry ink / toner from the fuser. The felt is applied against the pressure roll, and
any residual dry ink / toner is removed; this method does not use paper.

Note
You must be logged in as an administrator in order to use the “Clean with Felt”
method.

For more information about the “Clean with Felt” method, refer to the System
Administration Guide for the press.

Performing the Clean Fuser Assembly Procedure
This procedure uses the “Clean with Paper” method and does not require administrator
login.

Note
If you still notice contaminants on the back of the prints after running this procedure,
contact your Xerox Service Representative. Dry ink / toner debris may be coming from
the transfer roll area instead of the fuser.

1. Select the Tools button on the press control panel.
2. Select Clean Fuser Assembly.
3. For Paper Supply, select the paper tray to use.

Note
Any type of paper and size can be used. However, the smooth surface of coated paper
does offer more contact area to the pressure roll.

4. For Number of Sheets, select the number of blank sheets to print (1 to 5).

Note
For best results, run fewer sheets for a multiple number of times. It is more effective
to run one or two sheets for multiple times than to run five sheets for one time only.
This is especially important when running larger sheets, in the short-edge-feed (SEF)
direction, such as 11 x 17 in. / A4 paper.

5. Select Save.
6. Press the Start button.

The system begins the cleaning process.

Note
When running five sheets of paper, the process takes approximately one minute.

When the cleaning process is finished, a “successfully completed” message displays.
7. Select OK.
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Cleaning the Raster Output Scanner (ROS) Window Areas
Unfused dry ink / toner collects on the four color raster output scanner (ROS) window
areas located just above the drum cartridge drawer inside the press. Contaminated ROS
windows can cause a white streak defect on your printed output.

If you notice white or light streaks on prints, to resolve this issue, clean the ROS windows
with the following procedure.

Important
Use only the cleaning wand and cloth pad provided when performing this procedure.
Do not use any other cleaning device, liquid solutions, or cloths.

1. Open the left and center front doors of the press.

2. Locate and remove the cleaning wand tool stored on the inside panel of the left front
door.

3. Make sure the pad at the tip of the wand is clean.
Several pads are provided with the cleaning wand when the press is installed.

Note
Replace the pad when it becomes a dark color. Always use a clean pad in order to
ensure optimum image quality on the printed output.

To acquire additional pads, contact your Xerox Service Representative.

4. Clean one of the ROS windows:
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a) With the pad facing upward and the felt-tip first, insert and gently push thewand
fully into the ROS window opening.

b) Pull the wand fully out towards you.

c) Repeat the push-in and pull-out motion two or three additional times.

5. Remove the tool, insert it into the next hole, and repeat the previous step.
Continue until you have completed the procedure for all four ROS windows.

6. Replace the cleaning wand tool into the storage area on the inside panel of the left
front door.

7. Close the left and center front doors of the press.

Performing the Clean Toner Procedure
Important
The following procedure is performed only by a person who has press administrator
privileges and is logged onto the press as administrator. Non-administrator users must
contact an administrator in order to to complete this procedure.

Use the Clean Toner procedure after running a low area coverage job which was then
followed by large area coverage job, and thereby experiencing toner agglomerates and
clumps on the output prints. The press runs a full-page halftone to purge the debris and
any residual dry ink / toner from the system.
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Note
It is recommended that you run a few test prints before performing the cleaning
procedure. After the Start Cleaning button is selected, the system automatically
generates a test print. This allows you to compare the before and after prints for image
quality.

1. At the press control panel, log in as the administrator.
2. Press theMachine Status button.
3. Select the Tools tab.
4. Select System Settings > Common Service Settings > Maintenance.
5. Scroll through the Maintenance pages, and select Clean Toner.
6. Select the desired dry ink / toner colors to clean.

If desired, you can select all the toner colors.

7. Press Start.
After the purge page prints, a Successfully Completed message displays.

8. To ensure that the problem is resolved, select Sample Print.
9. Select Close repeatedly until the main Tools screen displays.
10. Exit the administrator mode.
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Calibrating the Press
Note
The information contained in this section is about calibrating the press only.

For information about calibrating the print server, refer the SystemAdministrationGuide
for the press. Also refer to the print server documentation.

Full Width Array

Accessed from the press control panel, the Full Width Array feature calibrates the print
engine only. The in-line Full Width Array adjusts print engine color controls, provides
image density uniformity, and enables print server calibration and profiling without the
need to use an external spectrophotometer.

The FullWidth Array uses xerographic parameters and diagnostics to analyze the finished
image and correct errors in output color and density uniformity. This feature uses internal
color calibration strips (or tiles) as reference for known colors of a test pattern. These
color values are automatically adjusted to produce accurate and consistent reproductions.

The Full Width Array is located in the paper path after the fuser and contains an inline
scanner to provide print engine adjustments. The adjustments ensure uniformity of
toner on prints and image alignment.

The Full Width Array provides these two adjustments:

• Automatic Density Uniformity Adjustment: Run this image quality adjustment
when the printed output density is inconsistent (non-uniform) within the printed
page. Non-uniform, inconsistent density may appear as faded colors on portions of
the printed page (jobs running light and dark).

The press operator may perform this procedure, and it does not require system
administrator access.

• Automatic Alignment: This feature adjusts the print image position on paper.
Image-to-media alignment ensures correct positioning of the print image on paper
and is important for calibrating new media. Refer to the Stock Library Manager Help
on the print server for more information on this feature.

Note
This feature is available only from the Stock Library Manager on the print server
and not from Tools on the press control panel. It is available only to system
administrators using the Profiles function of the Stock Library Manager.

These Full Width Array quality control measurements and adjustments are automatic,
once you initiate them from either the Toolsmenu on the press control panel or from
the Stock Library Manager Profiles feature.
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The FullWidth Array improves operator and press productivity because it replaces lengthy
manual procedures for press print engine adjustment, saves time from scanning targets
with an external spectrophotometer, and uses simple steps that previously required a
service engineer for some procedures. The Full Width Array can also be used to save
time by automatically scanning and measuring targets when performing print server
calibration and profiling initiated from the print server. Refer to the SystemAdministration
Guide and Stock Library Manager on the print server for more information.

Tip
Before running color-critical jobs, run the Density Uniformity Adjustment procedure and
use the calibration features at the print server to ensure that your press maintains the
best image quality with less or no down time.

Note
Refer to your print server user documentation when performing the calibration workflow
of the print server in conjunction with the print engine. Alignment and registration
adjustments are performed at the print server.

Density Uniformity Adjustment

Density Uniformity Adjustment is done to ensure even toner density across each page.

The press prints density test patterns, scans themandautomatically corrects for variations
by resetting software controls. Uniformity is important for high area coverage applications
where density drift from edge to edge can impact image quality. Density Uniformity
Adjustment saves time because without it a service call is required to make this type of
adjustment.

Run Density Uniformity Adjustment to correct inboard to outboard density uniformity
defects; for example, the image quality is lighter (faded) or heavier (thicker) on the left
or right sides of the output (inboard / outboard). Also runDensity Uniformity Adjustment
after xerographic components are replaced.

Note
Density Uniformity Adjustment does not require system administrator access and may
be performed by the operator from the press control panel.

Adjusting Automatic Density Uniformity
1. Press the Tools button on the control panel.
2. Select Full Width Array Density Uniformity Adj.
3. Select the Paper Supply button.
4. Select a tray containing 11 x 17 in. (A3) or 12 x 18 in. (SRA3) paper.
5. Select Save.

You may have to wait a few minutes while the Full Width Array gets ready.

6. Select Start.
The press prints the test targets, measures them, and automatically adjusts the toner
density for consistent application across the page.
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Note
The printed sheets do not yet reflect the new settings but are the sheets that were
used to make the adjustments.

7. Decide if you want to visually check the new settings:

• You do not want to print sheets with the revised settings; therefore, select Save
and Close.

• You dowant to print sheets with the revised settings; therefore, select the Sample
Printout button to view the adjustment prints.

Sample sheets print using the updated settings.

8. Check the printed samples for density uniformity / consistency.

• Verify that each line of color shows even density across the page, as shown in the
following illustration:

* Check for uniform, consistent density across all color bars as indicated by the
arrows in the above illustration.

If acceptable, select Save and Close.

• If the results are not acceptable, repeat the previous steps of this procedure.

9. Select Close to complete the Density Uniformity Adjustment.

Replacing Consumable Supplies
Note
Refer to www.xerox.com for the latest consumable part numbers.

The following items are the Customer Replaceable Units (CRU) for the press. It is
recommended that you have a supply of these items available to eliminate down time
when they need to be replaced.

• Dry Ink / Toner cartridges (C, M, Y, K)
• Drum cartridges (C, M, Y, K)
• An empty Waste Dry Ink/Toner bottle
• Trays 5, 6, and 7 feed rolls
• Suction Filter
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Note
Store supply items and Xerox parts in their original packages in a convenient location.
Always recycle / dispose the used CRU according to the disposal instructions supplied
with the new CRU.

Ordering Supplies

Xerox supplies, paper, and throughput material can be ordered from the web site
www.xerox.com and clicking on the Supplies link. For any item that is not orderable from
the web site, contact your Xerox Service Representative.

Note
The cleaning pads used with the ROSWindow cleaning wand are not orderable. Contact
your Xerox service representative for any additional cleaning pads.

Approximate Print Yield
(Full Color 8.5x11/A4 Prints)

Reorder QuantityCRUs (Supply Item)

50,000*2 per boxBlack Dry Ink / Toner Cartridge

55,000*1 per boxCyan Dry Ink / Toner Cartridge

51,000*1 per boxMagenta Dry Ink / Toner Cartridge

51,000*1 per boxYellow Dry Ink / Toner Cartridge

45,0001Waste Dry Ink / Toner Bottle

200,0001Suction Filter

348,0001 per boxDrum Cartridge (R1)

348,0001 per boxDrum Cartridge (R2)

348,0001 per boxDrum Cartridge (R3)

348,0001 per boxDrum Cartridge (R4)

500,0001 kitFeed Roll Kit (Trays 6/7)**

* Dry Ink / Toner yield projections are based on 7.5 percent-area coverage per color (4
colors = 30 percent) at standardized conditions on A4 (8.5 x 11 in.), for Xerox Digital
Color Xpressions+, 24 lb. (90 gsm) and for Colotech Plus 90 gsm reference paper.

**Each tray requires its own feed roll kit: one kit for Tray 5, one kit for Tray 6, and one
kit for Tray 7. Each kit contains all the required items for replacing the feed rolls.

Checking the Status of Consumables

The Supplies area of the Home window on the press control panel displays an overview
of the level of dry ink / toner remaining in each cartridge. As the dry ink / toner is used,
the colored line representing each cartridge becomes shorter.
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When a consumable is reaching the time it needs to be replaced, amessage is displayed
on the control panel touch screen. This indicates when it is time to order and/or install
a new consumable item. With some Customer Replaceable Units (CRUs), the screen
indicates that the press may continue to run print jobs without immediately replacing
the item. Otherwise, when it is time to replace it, a message appears and the press stops
running.

To check the status of your consumables:
1. Press the Home button on the control panel.

Notice the Supplies area showing a 1-to-100% indicator bar that shows the remaining
amount of dry ink / toner.

Note
Remaining dry ink / toner is updated in 10-percent increments.

2. To display the exact percentage of remaining dry ink / toner for each cartridge, touch

the Information button .
The Supplies screen displays.

3. From the menu, select Other Consumables to see the status of other consumables.

The Other Consumables window displays and provides information about the
percentage of remaining life for each consumable.
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4. Use the up / downarrows to see additional consumables, such as the drum cartridges,
the dry ink / toner waste container, trays 6/7 feeder rolls, and consumables for any
additional optional devices that are configured with the press.

Note
The status of the suction filter is not shown, but a message displays when it requires
replacement.
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Replacing the Tray 5 Feed Rolls
Note
To perform this procedure, the feed roll kit is required. The kit contains all the required
items for replacing the feed rolls.

Replace the feed rolls for Tray 5 (Bypass) when experiencing frequent multifeeds, single
feeds, or blank prints in the stack of the output prints.

3.1. Separator RollFeed Roll
2. Nudger Roll

1. Locate Tray 5 (Bypass) on top of Trays 6 and 7.
2. Lift up and open the bypass tray cover to access the feed roll components.

3. Remove the feed roll and install a new one.
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a) Remove the feed roll by squeezing the metal shaft at both ends and lifting it up
and out of the tray.

b) Install a new feed roll by squeezing the metal shaft at both ends and sliding it
into place.

4. Remove the nudger roll and install a new one.
a) Remove the nudger roll by squeezing the metal shaft at both ends and lifting

it up and out of the tray.

b) Install a new nudger roll by squeezing the metal shaft at both ends and sliding
it into place.

5. Remove the separator roll and install a new one.
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a) Remove the separator roll by squeezing themetal shaft at both ends and lifting
it up and out of the tray.

b) Install a new separator roll by squeezing themetal shaft at both ends and sliding
it into place.

6. Close the bypass tray cover.
7. Verify that the tray is operating correctly by feeding paper from the bypass tray.
8. Either log in as the administrator or ask the administrator to perform the following

steps to reset the High Frequency Service Item (HFSI) count to zero (0):
a) At the control panel, press the Tools button.
b) From the screen that displays, select the Tools icon.
c) Select System Settings > Common Service Settings > Maintenance.
d) Use the up / down arrow buttons to access the next Maintenance screens.
e) Select the Technical Key Operator icon. The Technical Key Operator feature

displays.
f) Select the bypass roll items that correspondswith the newly-replaced components.
g) Select Reset Current Value. The system resets the High Frequency Service Item

(HFSI) to 0.
h) Exit the administrator mode by pressing the Log In / Out button on the control

panel. When prompted, select Logout.
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Replacing the Tray 6/7 Feed Rolls
Note
To perform this procedure, the feed roll kit is required. The kit contains all the required
items for replacing the feed rolls.

Important
If replacing the feed rolls for both trays, ensure to obtain two feed roll kits (one for each
tray).

Replace the tray feed rolls every 300,000 prints or when experiencing frequentmultifeeds,
single feeds, or blank prints in the stack of the output prints.

The tray feed rolls include the following components:

3.1. Separator Roll (shown with the feed
roll removed)

Nudger Roll
2. Feed Roll

1. To access the feed components , pull out the tray slowly until it stops.

2. Replace the nudger roll:
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a) Remove the nudger roll by pushing down on the black tab with one hand (which
raises the roll upward) and then squeezing the metal shaft on both ends with
your other hand.

b) Lift out the nudger roll.
c) Install a new nudger roll by squeezing both ends of the metal shaft, and while

pushing down on the black tab, insert and release the roll ends into the notches.

3. To access the separator roll, remove the separator roll assembly at the side of the
tray:
a) Unscrew the three thumbscrews.

b) Slide the separator roll assembly all the way to the left so it is out of the slots.
c) Pull the assembly out towards you until completely removed from the tray, and

set aside the assembly.

4. With the separator roll assembly out, replace the feed roll:
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a) To remove the feed roll, squeeze both ends of the metal shaft and lift out.

b) To install a new feed roll, squeeze both ends of the new roll shaft, insert and
release the roll ends into the notches.

5. Replace the separator roll:
a) To remove the roll from the assembly, squeeze the shafts of the separator roll

and lift out of the assembly.

b) To install a new separator roll, squeeze both ends of the new roll shaft, insert
and release the roll ends into the notches on the separator roll assembly.

6. Reinstall the separator roll assembly into the tray.
a) Align the cutout holes of the assembly with the frame of the tray so the pin holes

match up.

Xerox® Versant® 3100 Press6-18
User Guide

Maintenance



b) Insert the assembly into the frame.
c) Slide the assembly all the way to the right using the pin as a guideline.
d) Ensure the device is all the way into the slots and the three screw areas align.

e) Screw in the three thumbscrews to attach the assembly. Do not over tighten.

7. Close the tray and verify that the tray is operating successfully by feeding paper
using that tray.

8. Either log in as the administrator or ask the administrator to perform the following
steps to reset the High Frequency Service Item (HFSI) counters to zero (0) for each
component.
a) At the control panel, press the Tools button.
b) From the screen that displays, select the Tools icon.
c) Select System Settings > Common Service Settings > Maintenance.
d) Use the up / down arrow buttons to access the next Maintenance screens.
e) Select the Technical Key Operator icon.

The Technical Key Operator feature displays.

f) Select the item that corresponds with the newly-replaced components.
g) Select Reset Current Value. The system resets the High Frequency Service Item

(HFSI) to 0.
h) Repeat the previous steps until the counters for all three components are reset

to zero (0).
i) Exit administratormode by pressing the Log In / Out button on the control panel

When prompted, select Logout.
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Replacing a Dry Ink / Toner Cartridge
Note
The dry ink / toner cartridge can be replaced while a job is printing.

1. Open the dry ink / toner cover, located just above the press front door / cover.

2. Lay paper on the floor before removing the cartridge. This will allow any excess dry
ink / toner to fall on the paper.

3. Slowly remove the dry ink / toner cartridge by placing fingers under the end of the
cartridge and gently pulling it straight out. While pulling out, hold the bottom of the
cartridge with your other hand to give it support.

Ensure that you are removing the same cartridge thatmatches the color as indicated
in the message.

4. Dispose of or recycle the cartridge per your local authorities and regulations.
In the United States, also refer to the Electronic Industries Alliance website:
www.eiae.org. For more information about Xerox environmental programs, go to
www.xerox.com/environment.

5. Remove the new dry ink / toner cartridge from its packaging.
6. Prepare the cartridge for installation:
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Note
The dry ink / toner material inside the new cartridge is compact. Loosen and
redistribute the dry ink / toner material before placing into the dry ink / toner slot.

a) With one hand on either side of the cartridge, vigorously shake and rotate the
new cartridge up and down and then left and right for 30 seconds.

b) Test whether the dry ink / toner material is distributed sufficiently by turning the
auger on the end of the cartridge.

c) If the auger does not turn easily, continue to shake the cartridge and loosen the
dry ink / toner material. When the auger turns without resistance, the dry ink /
toner cartridge is ready for installation.

7. Install the dry ink /toner cartridge by aligning it straight out from the press and gently
sliding in until it stops.

8. Close the dry ink / toner cover.
If the cover does not close completely, make sure the cartridge is in the lock position
and is installed into the appropriate dry ink / toner location.

Note
After you replace a dry ink / toner cartridge, the system automatically resets the High
Frequency Service Item (HFSI) usage counter for this CRU to zero (0). Check the
consumables Supplies screen to verify the reset and new status.
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Replacing the Dry Ink / Toner Waste Bottle

The dry ink / toner waste bottle collects dry ink / toner that accumulates during the
printing process.

Note
When the waste bottle is full, a message displays on the press touch screen informing
you to exchange the full bottle with an empty one.

1. Ensure that the press is stopped (not running any jobs).
2. Open the center front door and locate the waste bottle.

3. Grasp the handle of the dry ink / toner waste bottle and slowly pull it halfway out of
the press.

Slowly pulling out the bottle prevents any dry ink / toner from spilling.

4. Continue slowly pulling out the bottle until it is removed from the press:
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a) While grasping the handle with one hand, grip the top of the bottle with the
other hand.
The waste bottlemay be heavy; therefore supporting the bottle with both hands
ensures that no dry ink / toner is spilled while removing the bottle.

b) Continue slowing pulling out the bottle from the press until it is completely
removed.

Caution
Never use a vacuum cleaner when cleaning up any spilled dry ink / toner. Use a
broom or a cloth moistened with a neutral detergent.

5. Place the full waste bottle into the plastic bag provided with the bottle.
6. Remove a new, empty waste bottle from the packaging.
7. Hold the center part on the top of a new bottle and insert it gently into the press until

it comes to a stop.

8. Close the center front door.

Note
After you replace the dry ink / toner waste bottle, the system automatically resets
the High Frequency Service Item (HFSI) usage counter for this CRU component to
zero (0). Check the consumables Supply screen to verify the reset.

Replacing the Suction Filter
Important
Before performing this procedure, ensure that you have the required T10 Torx driver
tool.

After replacing the filter, contact the system administrator. The administrator must log
into administrator mode and reset the High Frequency Service Item (HFSI) counter for
this CRU to zero (0).

Caution
Make sure the press is powered off before performing this procedure.

1. At the back of the press, locate the suction filter cover on the lower panel.
2. Us the Torx driver to remove the screw on the right side of the cover by turning the

screw counterclockwise (left).
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3. Pull out and remove the suction filter cover.
4. Grasp the handle of the filter box and pull straight out.

5. Remove the suction filter from the box.
6. Place the new suction filter into the box and push the filter box in until it stops and

is flush with the press.
7. Place the cover onto the filter box area.

Make sure to first insert the left two tabs of the cover into the left side of the box
area. Then push the entire cover flush to the press.

8. Insert the Torx driver with the screw attached into the cover and turn clockwise (right)
to tighten.

9. Either log in as the Administrator or ask the Administrator to perform the following
steps to reset theHigh Frequency Service Item (HFSI) count to zero (0), which indicates
a new filter has been installed.
a) At the control panel, press the Tools button.
b) Select the Tools icon.
c) Select System Settings > Common Service Settings > Maintenance.
d) Use the up / down arrow buttons to access the next Maintenance options.

Note
After selecting the icon in following step, there is a 4 second delay before the
Technical Key Operator feature displays.

e) Select the Technical Key Operator icon. The Technical Key Operator feature
displays.

f) In the Part Number list, select Suction Filter.
g) Select Reset Current Value. The system resets the HFSI to 0.

10. Exit administrator mode.
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a) To return to Tools tab, select Close twice.
The main Tools screen displays.

b) Select the Log In / Out button on the Control Panel.
c) When prompted, select Logout.

Replacing a Drum Cartridge

Other than replacing a drum cartridge after 348,000 prints, you may need to replace a
drum cartridge if it is damaged by light or you are experiencing spots and streaks on
your output.

Note
All four Drum cartridges are interchangeable.

Important
After replacing the drum cartridge, the system automatically resets the High Frequency
Service Item (HFSI) usage counter of this CRU component to zero (0). Check the
Consumables screen for the reset and new status.

Caution
Do not leave the Drum Cartridge Drawer open for more than one minute. Exposing the
drum cartridges to direct sunlight or strong light from indoor fluorescent lighting for
more than one minute may cause image quality defects.

Caution
Replace drum cartridges while the press is powered ON.

1. Ensure that the press is stopped and not currently printing jobs.
2. Open the press Left and Center Front doors.
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3. Turn the R1-R4 Drum Drawer Handle clockwise (right) to the unlock position.

4. Grasp the Release Handle and pull out the Drum Drawer until it stops.

5. Remove the old drum cartridge by holding the finger rings provided at the both ends
of the drum cartridge and gently lifting up.

Caution
Drums are light sensitive. Do not leave the Drum Cartridge Drawer open for more
than one minute when replacing cartridges. Exposing the drum cartridges to direct
sunlight or strong light from indoor fluorescent lighting for more than one minute
may cause image quality defects.

6. Clean under drum cartridge area:

Xerox® Versant® 3100 Press6-26
User Guide

Maintenance



a) With theDrumCartridgeDrawer open, look for dry ink/toner waste on the bottom
of the catch pan under the drum cartridges.

b) Use a clean cloth to wipe down the catch pan.

7. Open the bag containing the new drum cartridge. Place the new drum cartridge near
the press.

Caution
Do not touch or scratch the surface of the drum when you take it out from the bag.

8. Unwrap the sheet covering the new drum cartridge and place it under the cartridge.

Note
Some drum cartridges may include a protective film. If the film is present, remove
the film on the drum cartridge.

9. Using the finger rings, install the new drum cartridge into the press with the side
marked front facing the front.

10. Press both ends of the drum cartridge to place it in a horizontal position.

11. Immediately close the drum cartridge drawer to protect the other drums from light.
12. Return the Release Handle to its original position.
13. Return the R1-R4 handle to the original position and close the press left and center

front doors.
14. Insert the used drum cartridge into an empty container for recycling.

Fuser Assembly Procedures
Important
The fuser assembly (fuser belt, pressure roll, stripper fingers, and pressure roll cleaning
pad) must be replaced only by a qualified Technical Key Operator (TKO) or Service
Representative. In special infrequent cases and only when directed by service, the
customer may replace fuser assembly.

6-27Xerox® Versant® 3100 Press
User Guide

Maintenance



Fuser Assembly procedures should be performed in the following order:

Procedures to Perform in Sequential OrderFuser Component to Remove / Replace

Removing and reinstalling the same fuser or
swapping fusers

1. Removing the Fuser Module
2. To install the fuser, refer to that procedure

Installing the Fuser Assembly.

Removing the fuser and installing a new fuser 1. Removing the Fuser Module
2. To install the fuser, refer to that procedure

Installing the Fuser Assembly.

Replacing the stripper finger assembly 1. Removing the Fuser Module
2. Replacing the Stripper Finger Assembly
3. To install the fuser, refer to that procedure

Installing the Fuser Assembly.

Replacing the pressure roll assembly 1. Removing the Fuser Module
2. Replacing the Stripper Finger Assembly
3. Pressure Roll Assembly
4. To install the fuser, refer to that procedure

Installing the Fuser Assembly.

Replacing the pressure roll cleaning pad as-
sembly

1. Removing the Fuser Module
2. Replacing the Stripper Finger Assembly
3. Pressure Roll Assembly
4. Replacing the Pressure Roll Cleaning Pad

Assembly
5. To install the fuser, refer to that procedure

Installing the Fuser Assembly.

Fuser Assembly Cautions and Warnings

Before performing any fuser assembly procedures, always review the following cautions
and warnings:

Warning
You must wait fifty minutes to allow the fuser assembly to cool down to a safe
temperature before performing any fuser assembly procedures.

Caution
When pulling out the transfer drawer to the service position, do not attempt to pull the
drawer further out towards you. Pulling the drawer further out will disengage it from the
rails resulting in damage to the drawer and possible injury.
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Caution
Make sure the press is powered off. Do not perform this replacement procedure with
the power on or electrical power supplied to the system. Allow the fuser to cool down
for fifty minutes before performing any maintenance.

Reasons for Removing / Replacing Fuser Assembly Components

The reasons for removing and / or replacing the fuser assembly components include:

• After 650,000 prints or if damaged, replace the entire fuser assembly, which includes
the following components:

- Belt Module (choose up to three different modules available for fuser width
change; at installation, one standard fuser is provided)

- Pressure Roll
- Stripper Finger Assembly
- Pressure Roll Cleaning Pad

• When experiencing image quality issues or damage in the fuser area
• When accessing other components within the fuser assembly area for maintenance
• When an edgewear defect occurs: If you run amixed type of jobwithin your workflow

and switched from running 11-inch paper to large-sized paper, this could cause an
edgewear defect. To resolve, you can exchange and use another fuser belt module,
up to three different widths (for example, 11 inch / A4 width, 12 inch width, or a
custom size)

Note
If you exchange the fuser type, you will need to also connect the associated jumper to
the assembly to identify the fuser width ID being used. Refer to Changing the Fuser
Width ID.

Preparing the Tools

While waiting for the fuser assembly to cool down, locate the tools required to complete
the removal and replacement procedures:

• Fuser Holding Rack
• T10 and T15 Torx drivers (located in the Nationalization Kit)
• Fuser Handles (originally stored inside the Paper Tray 2 compartment)
• Pressure Roll Handles (originally stored inside the Paper Tray 2 compartment)
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Removing the Fuser Module

Warning
You must wait fifty minutes to allow the fuser assembly to cool down to a safe
temperature before performing any fuser assembly procedures.

Caution
When pulling out the transfer drawer to the service position, do not attempt to pull the
drawer further out towards you. Pulling the drawer further out will disengage it from the
rails resulting in damage to the drawer and possible injury.

Caution
Make sure the press is powered off. Do not perform this replacement procedure with
the power on or electrical power supplied to the system. Allow the fuser to cool down
for fifty minutes before performing any maintenance.

1. Power off the press by pressing the On/Off button.

2. When the indicator light stops blinking, open the left and the center front doors.

3. Switch off the main power switch.
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4. Wait fifty minutes to allow the fuser assembly to cool down to a safe temperature.
5. To unlock transfer drawer, locate the green handle (2) and rotate it clockwise (right)

to the horizontal position.

6. Slowly pull out the Transfer Drawer until it stops; this is its jam clearance position.

7. Pull out the Transfer Drawer to its extended position:

Warning
Do not extend the drawer beyond this service position. Pulling the drawer further out
will disengage it from the rails resulting in damage to the drawer and possible injury.

a) While gently pulling out the drawer, use the pointed end of the Fuser BeltModule
Handle to push through the hole in the Transfer Drawer rail to release the tab
on one side of the drawer.

b) Repeat the previous step for the other side of the drawer.
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8. Locate the black Fuser Front Cover.

Notice if there is a black or gray fuser width identifier clip at the front left side of the
cover. The clip identifies the width of the fuser currently installed, such as 13 inch. If
there is no clip and jumper connected (this is the default at install), the standard
fuser is installed, which accommodates all paper widths.

9. Using the provided T10 Torx driver, remove one screw and the Fuser Front Cover.

Caution
Save all screws for reinstallation. If you drop a screw inside the Fuser Assembly, locate
and remove the screw before continuing. Otherwise, the press could be damaged or
an image quality issue or fault code may result.

10. Remove the two mounting screws using the provided T15 Torx driver and lift the
Fuser Top Cover to the access position.

11. If there is a jumper harness attached to the wire bundle, it identifies the fuser width
restriction / resistance. One of two resistance jumpers may be installed. No jumper
(this is the default) indicates that the standard fuser is installed. Disconnect the four
Fuser connectors:
a) Pinch the tabs on both sides of the black connector and lift to remove.
b) Using a Torx driver, gently push the tabs in on each of the three white connectors

while pulling slightly on the wires to remove.
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c) Release the wire bundle from the harness clip.

12. Locate the storage area of the press that holds the pack of Fuser and Pressure Roll
Lift Handles. Remove the Lift Handles pack from the storage area.

13. Place the Fuser Belt Module Handles on the posts on each end of the module.

14. Facing the right side of the drawer, push the module slightly away from you and lift
the Fuser Belt straight up and out of the press, letting the weight of themodule hang
in your hands.

Note
Do not twist or rotate the module as you place it in the Holding Rack.

15. Place it on the Fuser Holding Rack provided. Align the edge of the roller to the scribe
mark on the holding rack frame.

16. If damaged or end-of-life, place it inside the original box and return to Xerox for
recycling.

17. With the Fuser Belt removed, you can now remove and replace the Fuser Stripper
Finger Bracket, the Fuser Pressure Roll Assembly and the Pressure Roll Cleaning Pad
Assembly. Refer to those procedures.

18. If a different width fuser is going to be installed, remove the new fuser from its
packaging. Store the unused fuser in its original box.

19. To install the fuser, refer to that procedure Installing the Fuser Assembly.

Replacing the Stripper Finger Assembly

Caution
Make sure the press is powered off. Do not perform this replacement procedure with
the power on or electrical power supplied to the press. Allow the fuser to cool down for
50 minutes before performing any maintenance.
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1. Perform the steps for Removing the Fuser Module.
2. Once the Fuser Belt Assembly is out of the press, you can access and remove the

Fuser Stripper Finger baffle:
a) Using the T10 Torx driver, remove the two screws and the Fuser Entrance Baffle.

Set aside the screws for reinstallation.
b) Note the position of the Fuser Belt Edge Sensor so as not to damage it when

removing the Pressure Roll.
c) Press the front and back Spring Levers at the same time and lift out the Stripper

Finger Assembly.

3. To replace the Stripper Finger Assembly, align the two slots in the assembly with the
two posts and click into place.

4. Position the Entrance Baffle by aligning the two perforations and the two screw holes.
5. Reinstall the two screws to secure the baffle.
6. Ask the administrator to reset the High Frequency Service Item (HFSI) count for this

newly-replaced CRU component at the press Control Panel.

Replacing the Pressure Roll Assembly

Caution
Make sure the press is powered off. Do not perform this replacement procedure with
the power on or electrical power supplied to the press. Allow the fuser to cool down for
50 minutes before performing any maintenance.

1. Perform the steps for Removing the Fuser Module.
2. Perform the steps for Replacing the Stripper Finger Assembly.
3. Once the Fuser Belt Assembly is out of the press and the stripper finger bracket

removed, you can access and remove the Pressure Roll Assembly:
a) Push down and release the front and back Bearing Holder Springs, and move

each spring into the holding position.
b) Install the Pressure Roll Handles under the bearings on each side of the roll.
c) Lift the Pressure Roll straight out of the press and place in an available box.

4. Install the new Pressure Roll Assembly. Use the Pressure Roll Handles to help position
the Pressure Roll in the Fuser Assembly.

5. Align the bearings to the cradle as you gently lower the Pressure Roll into place, and
then remove the handles.

6. Rotate the roll to ensure that the gears mesh properly.
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7. Replace the Bearing Holder Springs to secure the Pressure Roll in place.
8. Ask the administrator to reset the High Frequency Service Item (HFSI) count for this

newly-replaced CRU component at the press Control Panel.

Replacing the Pressure Roll Cleaning Pad Assembly

Caution
Make sure the press is powered off. Do not perform this replacement procedure with
the power on or electrical power supplied to the press. Allow the fuser to cool down for
50 minutes before performing any maintenance.

1. Perform the steps for Removing the Fuser Module.
2. Perform the steps for Replacing the Stripper Finger Assembly.
3. Perform the steps for Replacing the Pressure Roll Assembly.
4. To remove the Pressure Roll Cleaning Pad, use a T15 Torx driver and loosen the one

screw in the front of the press. It is not necessary to remove the screw.
5. Push the pad to the rear of the press and remove it.
6. Install the new cleaning pad. Make sure to align the locking tabs with the holes in

the frame and once the Cleaning Pad Assembly is seated, push the assembly towards
the front of the press against the screw.

7. Tighten the screw to secure the pad in place.
8. Ask the administrator to reset the High Frequency Service Item (HFSI) count for this

newly-replaced CRU component at the press Control Panel.

Installing the Fuser Assembly

Use this procedure to reinstall the existing fuser assembly or to install a new fuser
assembly.

Perform this procedure only after removing the fuser assembly and/or replacing the
other fuser components.

Note
If installing a fuser with a different width fuser, remove the new fuser from its packaging.
Otherwise, retrieve the fuser that was removed previously and which is sitting on the
Holding Rack.
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Important
To replace the fuser assembly correctly, be aware of the three alignment points: There
are two alignment points in the front and one in the back of the assembly. Proper
alignment ensures proper performance.

1. Place the Fuser BeltModule Handles on each side of the belt and reinsert the required
Fuser Belt Module into the Fuser Assembly.

2. Using the handles, position the Belt Module into the Fuser Assembly using the three
alignment points. The Belt Module can be moved front to back and side to side to
achieve the proper placement.

Make sure the fuser is seated correctly and completely or the Fuser Top Cover will
not close and machine damage may result.

3. To validate the Belt Module is installed properly, gently close the Fuser Top Cover. If
it closes completely, themodule is installed correctly. If it does not close, try to reinstall
the Fuser Belt Module again. Leave the Top Cover open.

4. Replace the wire bundle into the harness clip. Reconnect the three white connectors
at the front of the Fuser by pushing into place.
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5. Push the black connector in until it clicks into place.

Note
The threewhite connectors are keyed and cannot bemixed up. The smallest connector
is in the back and the largest is in the front.

Note
Notice that the small white connector with the two black wires does not need to be
connected for this configuration.

6. Gently close the Fuser Top Cover. Reinstall the two larger screws using the T15 Torx
driver.

Note
You must reinstall the Front Fuser Cover.

7. Replace and secure the Fuser Front Cover with the smaller T10 screw.

Warning
You must push the drawer in. Pulling the drawer further out will disengage it from
the rails resulting in damage to the drawer and possible personal injury.

8. To push in and close the Transfer Drawer, press the rail tabs on each side of the
drawer with your fingers as you gently push the drawer into the press.

9. Latch the Transfer Drawer and close the press left and center front doors to complete
the procedure.

10. Ask the administrator to reset the High Frequency Service Item (HFSI) count for this
newly-replaced CRU component. The HFSI components that need to be reset at the
press touch screen are:

• Belt Module 1 (No Fuser connector)
• Belt Module 2 (Fuser connector 1)
• Belt Module 3 (Fuser connector 2)
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Extending Fuser Life with Multiple Fusers

While the press is installed with only one type of fuser (standard type), the system is
able to detect three different fuser width settings. Discuss the usage of multiple fusers
with your Service Representative. Multiple fusers provide maximum print output for
longer periods of time and ensure image defects on output are avoided. Depending on
the types of jobs run and their frequency, you may want more than one fuser available,
such as the following for example:

• One fuser roll for narrower paper
• One fuser for wider paper

Preventing Fuser Damage

Refer to the following information for tips on preventing damage to the fuser:

• To reduce 11 in./279.4 mm lines and wear marks, you may require the use of two
fusers - one when running 8. 5x 11 in./A4 stock, and the other when running 12 x 18
in./304.8 x 457.2mmor larger stock. This is especially true for the graphic arts people.

• Image quality defects such as marks or spots will occur every 110 mm/4.3 in. on the
prints if the fuser roll is damaged. Defects which occur every 98 mm/3.89 in. indicate
a damaged fuser belt.

Fuser Paper Width Information

The press is delivered and installed with a standard type fuser that accommodates all
paper width sizes. However, the press allows for the installation of other fuser assemblies
and paper width types for printing specific paper width ranges. When installing a new
fuser, the customer can indicate that the fuser be used for certain paper widths only.
Identifying the fuserwidth type is performedby connecting the appropriate fuser jumpers
provided in the nationalization kit as well as attaching a colored fuser width clip.

To optimize your image quality, you can exchange the standard fuser with a maximum
of three different width fusers. Use the different jumper resistance connectors to identify
a specific fuser and match the fuser with the designated paper width NVM settings.
Also, a clip on the fuser front cover identifies the width of the fuser being used.

Note
Before using the new fuser, the systemadministratormust update theNVMwidth setting
values to match the specific width used for this fuser.
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The following table defines the media sizes, width ranges, and default NVM values that
can be set for the fuser.

Table 1: Bypass Connector Used for Default Paper Width NVM Settings

NVM Default ValueWidth RangeMedia SizeBypass Connect-
or

Range Num-
ber

980-330298.0 - 330.2 mm
(3.858 - 13.0 in.)

All paper widthsNone1

1800-2499
2704-298
0

180.0 - 249.9mm
(lower limit)
270.4 - 298.0mm
(upper limit)

A4 / Letter SEF
A3 SEF
A4 / Letter LEF
11 x 17 in.

Black Resistor
Type

2

3000-3100
3070-3302

300.0 - 310.0mm
(lower limit)
307.0 - 330.2mm
(upper limit)

SRA312 in. /
13 in.

Blue Type3

100.0 - 330.2mm
(3.937 - 13.0 in.)

Custom4 See Note

Note
Refer to the System Administrator Guide for the procedure on how to reset NVM settings for
other widths not shown in this table.

Changing the Fuser Width ID

The press is installed with a default standard fuser type that is suitable for all media
sizes (paper widths). However, when removing the fuser module, you can optimize its
life and maintain the system’s image quality output by attaching a jumper connector
to the fuser assembly that identifies the specific paperwidth range to use. For information
and instructions, refer to Removing the Fuser Module.

If you plan to print jobs using a specific paper width, use this procedure to attach the
bypass connector for that fuser to the fuser assembly. This identifies to the system that
a different fuser is being used and only certain paper widths will be allowed to print.

The fuser types available are:

• 11 inch (A4 / Letter SEF) width fuser
• 12 inch (A3 SEF / A4 / Letter LEF / 304.8 mm) width fuser
• 13 inch (SRA 3/ 330.2 mm) width fuser
• Custom and other size papers
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Important
To identify the fuser type and set minimum and maximum NVM width values, inform
the systemadministrator. The administratormust set theNVM settings fromToolsmode
on the press control panel. When using a bypass connector with the fuser, the press
detects the fuser type and width and confirms it is appropriate for the system.

Note
The bypass connectors required for each fuser width type are located in the
nationalization kit which comewith the press. To order additional fusers for this product,
contact your Customer Support Center.

Warning
Before performing this procedure, power off the press and allow fifty minutes for the
fuser to cool down. Always observe the warning labels inside the press.

1. If required, have the system administrator update the NVM width range settings for
the fuser from Tools mode, and identify the specific width range of media that can
be run through the fuser.
Refer to the Default and Custom Paper Width Settings tables (in the Using the
Fuser NVM Read/Write Setting procedure) in the System Administrator Guide.
Always set the NVM settings before using the new fuser.

2. Open both the left and center front doors.
3. Locate the black fuser front cover.

4. Remove the fuser front cover by using the T10 Torx driver to unscrew the one
mounting screw at the center of the cover.
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5. Locate the fuser identifier clip on the fuser assembly and, using a marker, write on
the identifier the fuser width being used.

6. Locate the two bypass fuser connectors in the kit. The black resistor jumper (left) is
used for the number 2 range value and the blue jumper (right) represents the number
3 range value. For the range numbers, refer to the bypass connector table in Fuser
Paper Width Information. .

7. Attach the appropriate jumper to the exposed white connector at the front of the
fuser assembly by pushing the two ends together. There is no release. To disconnect,
simply pull apart.

8. Position the fuser front cover on the assembly and screw tightly in place.
9. Close the left and center front doors of the press.

Note
If the paper in the print job does not match the width set for the fuser, an error
message displays and the job does not print. Cancel the job and submit the correct
paper width for that job, or change fusers so that the correct width-range fuser is
installed.
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7
Troubleshooting

General Troubleshooting
The following table helps you resolve some basic problems you may encounter with the
press. If the problem persists after following all the instructions, contact your Xerox
Representative or the Customer Support Center.

Note
Before contacting Customer Support, refer to the Customer Diagnostic Tool and the
Stock Library Manager Help for additional problem solving information.

Note
If your print server indicates that the press has a fault and the press touch screen does
not readily display a message, refer to the Error History Report (Print Reports / Job
Status).

Problem

The press does not power on.

Suggested Solutions

• Ensure the power cord from the press is plugged into the power outlet / receptacle correctly.
If problem persists, press the main power switch inside the center front door to Off.1.

2. Firmly plug in the power cord.
3. Press the power switch on.

• Ensure the power switch inside the center front door is set to theOn position, and then press
firmly on the On/Off button at the control panel.

• Ensure that the power supply is 200 -240 V (volts), 30A (amperes).
• Ensure that supplied power capacity is compatible with the specified maximum power con-

sumption of the press (2.8 - 3.1 KVA).
• Check the ground fault interrupter (GFI) circuit breakers.
• If the power in your location is working properly, and you have tried the suggested solutions

but the press does not power on, contact the Customer Support Center for assistance.
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Problem

There is no power to the press and you cannot access the Machine Status screen to get the
press serial number.

Suggested Solutions

Open paper tray 1. The serial number is located on the left frame near tray 1. Refer to Locating
the Press Serial Number.

Problem

The press control panel is locked up, or the touch screen is completely dark.

Suggested Solutions

• If the control panel buttons or keyboard do not work, press the power button on the press
to power down the print engine. Wait thirty seconds and press the power button again to
reboot the system.

• If the Power Saver button is on (lit), the press is in the Power Saver mode. Press the Power
Saver button on the control panel to cancel the mode.

Problem

The press does not successfully complete a print job.

Suggested Solutions

• To verify that the press is connected to the network, print a test page from the print server.
• Verify that the power cable is connected to the press and to a suitable power outlet.
• Verify that the network cables are attached securely to the press and seated properly.
• Clear out the print job from the print queue and resend a print job.
• Power Off/On the press to restart it.
• Your press may not be configured on the network. To connect the press to the network,

contact your system administrator.

Problem

The press is taking longer than one minute before printing the next job.

Suggested Solutions

The system requires approximately two minutes when switching print modes in order to make
any necessary adjustments for the next print job, including color-to-color registration, density,
charge levels, bias levels, or other adjustments.

• The system has two print modes selectable at the print server:

- Four color mode (CMYK: cyan, magenta, yellow, black)
- Black and white mode only
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Suggested Solutions

• If the next print job is switching print modes, for example from black-only to four-color, the
system requires approximately two minutes to make any necessary adjustments.

• During this time, the touch screen displays the “Adjusting Image Quality” message.
• The next job begins printing once the system completes its adjustments.

Other information to remember includes:

• From a cold start (power on or power saver), the system takes less than five minutes to start
printing.

• From standby mode, the system usually takes less than one minute to start printing.

Problem

Print output contains corrupted text; the text prints incorrectly.

Suggested Solutions

Check the application or print driver settings on whether non-standard fonts are being used for
printing.

Problem

Trays do not recognize the media.

Suggested Solutions

• Access the Stock Library Manager on the print server, and check the paper settings for the
tray.

• Check the print server settings.
• Check that the paper is loaded correctly as either short-edge feed (SEF) or long-edge feed

(LEF), and ensure it matches the paper settings programmed at the print server.

Problem

Prints are not on desired paper size.

Suggested Solutions

• Ensure that the correct paper size and type is loaded in the paper trays.
• Set the paper guides to the correct positions.
• Select the paper size, tray and weight at the print server and ensure these paper attributes

are set correctly at the Tray Properties window.
• Ensure that Fit to Paper or an equivalent selection is not selected in your print driver.
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Problem

Paper jams and wrinkles in the fuser area.

Suggested Solutions

Check the stripper finger assembly and ensure it is notmisaligned or damaged. If it is damaged,
replace the stripper finger assembly; refer to Replacing the Stripper Finger Assembly.

Problem

Paper misfeeds, jams often, or wrinkles repeatedly.

Suggested Solutions

• If a message appears on the press touch screen, follow the instructions displayed.
• Ensure the paper and paper tray selectedmatch the paper size settings. Refer to the Recom-

mended Media List and to Matching the Tray and Stock Information.
• Ensure the trays are loaded properly with acceptable media and do not exceed the MAX fill

line.
• Ensure the paper tray edge guides are in the correct position. To ensure tray closure, firmly

push it in as far as possible.
• Turn the paper stack around and/or over in the selected paper tray.
• Remove a few sheets from the top and the bottom of the stack in the paper tray.
• Fan all four edges of the paper in the selected paper tray.
• Replace the paper in the selected paper tray with paper from a new package.
• Remove any partially fed paper from the trays. Remove any torn pieces of paper still remain-

ing inside the press.
• Ensure the paper you are using came from a properly-stored ream.
• Manage the Stock Library for the media in use. Refer to Stock Library Manager Help for

“Editing an Existing Stock in the Stock Library.”
• Check the consumable status of the feed rolls for tray 5, 6, 7, 8, or 9; if the status for one of

the trays is “Replace Now”, replace the feed rolls for that tray.
• If the problem is occurring only from Trays 6/7 or 8/9, refer to Stock Library Manager

Troubleshooting, and review Suggested Solutions for Multifeeds, Misfeeds, and/or Paper
Jams in Trays 6-9.

Problem

Multiple Sheets Fed from the Same Tray

Suggested Solutions

• Do not fill the paper trays above the MAX fill line indicator.
• Remove the paper from the tray and fan the sheets to separate the joined sheets.
• Predrilled (hole-punched) sheets may stick together at the holes. Remove the paper from

the tray and fan the sheets to separate the joined sheets.
• Paper and transparencies may stick together if environmental conditions are too dry and

cause excessive static. Increase the humidity level in the room to minimize static.
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Suggested Solutions

• Gently fan transparencies to separate the sheets before you load them.
• If the problem is from Trays 6/7or 8/9 only, refer to Stock Library Manager Troubleshooting

table, and review Suggested Solutions for Multifeeds, Misfeeds, and/or Paper Jams in Trays
6-9.

Problem

Excessive Paper Curl on Printed Output

Suggested Solutions

Potential impacts include:

• Incorrect paper weight/type selected; ensure that the correct paper weight and paper type
are selected

• The mass amount of dry ink / toner coverage on the print output; the greater amount of
the dry ink / toner mass, the more the paper curls

• The paper weight and whether or not it is coated or uncoated
• The humidity conditions at the press
• An attempt to print on thicker paper or on paper stock that is less sensitive to moisture

Reducing potential impacts:

• You can minimize curl problems by flipping the paper over in the tray. If excessive curl is still
present, use a heavier paper.

• To ensure continuous production, empty the output device when the output approaches
the maximum amount that the device can hold; refer to the specifications for that output
device for output limit amount.

- The Offset Catch Tray (OCT) holds a maximum capacity of 500 sheets of 24 lb. (90
gsm) paper.

- For all other optional finishing devices, refer to the Optional Devices Guide for Xerox®

Versant® 3100 Press for output specifications.

Paper curl can be adjusted in the following ways:

• If the InterfaceDecurlerModule is attached, use themanual decurl buttons on themodule's
control panel. Refer to theOptional Devices Guide for Xerox®Versant® 3100 Press for specific
information on this device.

• If the Production Ready (PR) Finisher or PR Booklet Maker Finisher is attached, use the
manual decurl buttons on the finisher. Refer to theOptional Devices Guide for Xerox®Versant®

3100 Press for specific information on these devices.
• Refer to the Stock LibraryManager Troubleshooting table, and review the Suggested Solutions

for Paper Curl.
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Reducing Toner Consumption

Problem

In order to maintain image quality (IQ), the press will enter “Adjust Image Quality” mode. In
this mode, toner is consumed in the form of toner bands and process control patches being laid
down. Frequency of the “Adjust Image Quality” is dependent on many factors including area
coverage. While printing jobs of low area coverage/low image density, the frequency of “Adjust
Image Quality” may be greater.

Suggested Solution

Three NVM values can be adjusted to reduce toner consumption based on user requirements.
Refer to the following table. From the first column of the table, select the solution which best
fits user requirements, and then change the NVM values as shown for each of the three NVM
settings.

Important
To select the outcome appropriate for your environment, contact the system administrator.

NVM 762-108NVM 752-175NVM 762-085User Requirement

Set NVM to 3Set NVM to 1 (On)Set NVM to 1 (On)1. Image Quality (IQ) Priority
These are the press default set-
tings which provide optimum IQ
output, but increase toner con-
sumption and may reduce pro-
ductivity.

Set NVM to 1Set NVM to 0 (Off)Set NVM to 1 (On)2. Middle Setting

Note
This is the recommended setting.

These settings configure the
press for less toner usage if im-
age quality is not the highest
priority. IQ may be slightly re-
duced.

No change requiredNo change re-
quired

Set NVM to 0 (Off)3. Lower Toner Consumption Pri-
ority
These settings decrease toner
usage and increase productivity,
but may result in degraded IQ.
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Image Quality (IQ) Troubleshooting
This section helps you locate and resolve image quality (IQ) defects.

Initial Actions

Perform these actions first to improve image quality:

• Manage the Stock Library for the media in use. Refer to Stock Library Manager Help
for “Editing an Existing Stock in the Stock Library.”

• Run print samples and evaluate the defect. From the following table, determinewhich
problem description matches the image quality defect and perform the appropriate
suggested solution.

Problem

Contamination on the back of prints
General contamination on backs of prints, or a specific toner-streak defect of 10–15 mm wide
running from long-edge / trail-edge (LE/TE), near the outboard side of the print.

Suggested Solutions

• Contamination can be media related.

- Look for paper damage, paper dust, or environmental conditions that may contribute.
- Ensure the media is fresh and properly loaded in the tray.

• Defects occur on heavyweight stock with lightweight stock settings. Manage the Stock
Library for the media in use. Refer to Stock Library Manager Help for “Editing an Existing
Stock in the Stock Library.”

• Perform the Clean Fuser Assembly procedure. If the defect is the specific streak on the back
of prints, theremay be a secondary-bias transfer roll (2nd BTR) failure. Contact the Customer
Support Center for service if the problem continues.

Problem

Banding on Prints
The print shows lines or bands running from the inboard-to-outboard (IB/OB) direction (side-
to-side direction).

Note
For defects running from the lead-edge to trail-edge (LE/TE) direction, refer to Streaks or Lines
on Prints.

Suggested Solutions

Measure the frequency of the spot intervals.

7-7Xerox® Versant® 3100 Press
User Guide

Troubleshooting



Suggested Solutions

Note
A measuring tool is provided in the nationalization kit that came with your press.

• If the defect is at the interval of 37.5mmor 147mm, replace the appropriate drum cartridge;
refer to Replacing a Drum Cartridge.

• If the defect is defect at the interval of 154 mm, replace the Pressure Roll Assembly.
• If the defect is at the interval of 375mm, replace the fuser assembly; refer to Fuser Assembly

Procedures.

Problem

Color Nonuniformity on Prints
The print has variations in color uniformity, such as:

• Uneven density
• Light or dark areas rrunning from the side-to-side direction (inboard-to-outboard)
• Color shift or inconsistent color throughout the page

Suggested Solutions

• Perform Cleaning the Raster Output Scanner (ROS) Window Areas.
• Run Performing the Clean Toner Procedure.
• Perform Adjusting Automatic Density Uniformity.
• Refer to Stock Library Manager Troubleshooting and review the Suggested Solutions for

“Uneven Density / Mottle.”

Problem

RandomWhite or Dark Spots on Prints
The prints show random spots, and they do not repeat at regular intervals.

Suggested Solutions

• Ensure that the media being used is approved, clean / clear of contamination, and is within
press specifications. Refer to the Recommended Media List for the press and to Paper and
Media.

• Check that the press is within environmental specifications (humidity levels); refer to Envir-
onmental Specifications

• Load a new ream of paper or different type of media.
• Run Performing the Clean Toner Procedure.
• Measure the frequency of the spot intervals.

Note
A measuring tool is provided in the nationalization kit that came with your press.

- If spots occur every 147 mm on the prints, run the Halftone Test Pattern to determine
which color drum is affected.

- Replace or swap the appropriate drum cartridge; refer to Replacing a Drum Cartridge.
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Problem

Repeating Defects at Regular Intervals on Prints
The prints show any defect type that repeats at intervals that can be measured.

Suggested Solutions

Measure the frequency of the spot intervals.

Note
A measuring tool is provided in the nationalization kit that came with your press.

• If the defect occurs every 44 mm on the prints, do not replace the drum. This interval is
caused by a damaged or defective developer housing. Contact the Customer Support Center.

• If spots or bands occur every 147 mm on the prints, a drum cartridge is damaged or light
shocked. Replace or swap the appropriate drumcartridge; refer to Replacing aDrumCartridge.

• If the defect occurs every 374 mm on the prints, replace the fuser belt assembly. Refer to
Fuser Assembly Procedures.

Problem

Streaks or Lines on Prints
The prints show solid color streaks or lines running from lead-edge to trail-edge (LE/TE) on the
prints.

Note
For image quality defects that run in the inboard-to-outboard (IB/OB) direction, refer to Banding
on Prints.

Suggested Solutions

• Perform Cleaning the Raster Output Scanner (ROS) Window Areas.
• If streaks or lines continue after cleaning the ROS windows, check for drum failure:

- Acquire or print the measuring tool.
A measuring tool is provided in the nationalization kit that came with your press.

- To determine which drum cartridge is affected, run the Halftone Test Pattern.
- Replace or swap the appropriate drum cartridge; refer to Replacing a Drum Cartridge.

Problem

Edgewear (Gloss Differential) on Prints
The inboard and outboard edges of the output prints shows dry ink / toner deletions, density
inconsistency, or is lacking in color depth. This occursmainly when using heavier or lighter weight
stock.

Suggested Solutions

If you runmultiple width papers, refer to Extending Fuser Life withMultiple Fusers and Preventing
Fuser Damage for more information.
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Problem

Halo or Smudges on Prints
Halo or smudges are on the printed output.

Suggested Solutions

Refer to Stock Library Manager Troubleshooting and review the Suggested Solutions for
“Uneven Density / Mottle.”

Problem

Image Density
Print output is too light, faint, or washed out; solid areas not black or inconsistent shading; part
of image missing.

Suggested Solutions

• Check the status of the consumables / supplies by pressing the Home button on the control
panel; refer to Checking the Status of Consumables.

• Shake or replace the affected dry ink / toner cartridge; refer to Replacing a Dry Ink / Toner
Cartridge.

• Determine if a drum cartridge is contaminated or light shocked by running a set of halftone
test patterns to identify which color is affected and then replace or swap the appropriate
drum. Refer to Replacing a Drum Cartridge.

• Run the Clean Toner procedure.
• Run Performing the Clean Toner Procedure.
• Refer to Stock Library Manager Troubleshooting and review the Suggested Solutions for

“Uneven Density / Mottle.”

Problem

Image-on-Paper Registration
The entire image on the printed output is misregistered, shifted, skewed, or crooked.

Suggested Solutions

• Ensure that the paper is loaded correctly and within press specifications; also refer to Paper
and Media for detailed specifications:

- Set the horizontal and vertical paper guides to the correct positions
- Ensure the paper tray guides are touching the edges of the loaded paper.
- Push the tray in completely.

• Refer to Stock Library Manager Troubleshooting and review the Suggested Solutions for
“Image Registration, Perpendicularity, Skew, or Magnification.”
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Problem

Unfused Prints / Fuser Offset
The image is not properly fused. Toner on print is not permanent, smears or flakes, or rubs off
the print.

Suggested Solutions

• Check that the paper weight settings at the print server match the actual paper loaded in
the tray; refer to Matching the Tray and Stock Information.

• Ensure that the paper loaded is within press specifications; refer to the Paper and Media
chapter for detailed specifications.

• After reviewing Paper /Media StorageGuidelines, load a new reamof paper into the selected
paper tray.

• Perform the Clean Fuser Assembly procedure.
• Refer to Stock Library Manager Troubleshooting and review the Suggested Solutions for

“Uneven Density / Mottle.”

Problem

Trail-Edge Deletions
Trail edge of the output contains dry ink / toner deletions, density inconsistency, or is lacking
in color depth. This occurs mainly when using heavier or lighter weight stock.

Note
For inboard or outboard edge deletions, refer to Edgewear (Gloss Differential) on Prints.

Suggested Solutions

• Create a custom stock and add to the Stock Library; refer to Stock Library Manager Help for
“Creating a New Stock (from the Stock Library Feature)” or “Creating a New Stock (from Tray
Properties).”

• Refer to Stock Library Manager Troubleshooting and review the Suggested Solutions for
“Uneven Density / Mottle.”

Stock Library Manager Troubleshooting
This section helps you locate and resolve specific problems through the use of the Stock
Library Manager. For detailed information on the features referred to in the following
tables, go to your print server and access the Stock Library Manager Help.

Initial Actions

Perform these actions first to improve print quality:

• Confirm the media being used is compatible with the Press, within supported
specifications, in good condition, and has been assigned to the correct Press Tray.
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Secondary Actions

If problems are not resolved after performing the suggested actions below, contact the
Customer Support Center.

Problem

Multifeeds, Misfeeds and Paper Jams in Trays 6-9

Suggested Solutions

The following solutionsmust be performed from the Stock LibraryManager on the print server.

Tip
All solutions provided here are accessed from the Advanced Stock Setup feature. Refer to the
Stock Library Manager Help for “Advanced Stock Setup Feature.”

1. Change the Tray Air Assist setting.

• Use this feature to adjust the amount of air volume generated by the tray blowers which
assist in separating sheets when feeding paper.When using light-weight or heavy-weight
paper, which stick together easily, select a stronger air flow setting in order to better
separate sheets and prevent paper jams or multifeeds.

• This feature can be found in Stock Library Manager > Stock Properties > Advanced
Stock Setup > Tray Air Assist.

• The settings available for this feature are:

- System Default: The air volume is set to the appropriate amount based on the
Stock and environmental conditions.

- Multifeed Support Table: Select this option if you use paper that tends to trigger
multifeeds. This setting increases the air volume to a level higher than System
Default.

- Mis-Feed Support Table: Select this option if you use paper that tends to trigger
paper jams. This setting increases the air volume to a level higher thanMultifeed
Support Table.

- Forced Off: Select this option when working with special media that tends to jam
as a result of the air flow that is introduced by Tray Air Assist. This setting turns
off Tray Air Assist.

2. Change the Enable Tray Heater setting.

• Use this feature to Enable (checked) or Disable (unchecked) the tray heater. The tray
heater warms the air that is blown into the tray by Tray Air Assist to help prevent paper
jams and multifeeds by loosening contact between sheets.

• The tray heatermay partially dry paper and affect print quality. If print quality is affected
by dry paper, Disable the tray heater.

Note
Disabling the tray heater may result in an increase of multifeeds.

• This feature can be found in Stock Library Manager > Stock Properties > Advanced
Stock Setup > Enable Tray Heater

• To Disable (unchecked) the tray heater:
a. Remove any paper loaded in the tray.
b. In Tray Air Assist select any option except Forced Off .
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Suggested Solutions

c. Disable (unchecked ) the tray heater and register the stock.
The printer performs a forced exhaust action for approximately one minute. During
the forced exhaust action, do not change any settings or open a tray.

Important
A forced exhaust with paper loaded in tray can lead to image quality problems.

d. After the forced exhaust is complete, load paper in tray.

3. Change theMultifeed Detection setting.

• Use this feature to Enable (checked) or Disable (unchecked) multifeed notifications;
this feature does not make any other adjustments.

• TheMultifeed Detection feature is accessed from Stock Library Manager > Stock
Properties > Advanced Stock Setup > Multifeed Detection.

• The settings available for theMultifeed Detection option include:

- Enabled (checked): Multifeed notifications are switched On.
- Disabled (unchecked): Multifeed notifications are switched Off.

Note
To prevent the system from reporting faults due to multifeeds, temporarily disable
notifications. This allows the user to continue their workflow until the cause of the
problem is resolved. Be aware that disabling this feature has no impact on the oc-
currence rate of actual multifeeds, and if disabled, multifed sheets may cause jams
elsewhere in the system and/or result in additional blank sheets in the final output.

Problem

Paper Curl

Suggested Solutions

1. If your press configuration includes the Interface Decurler Module (IDM)s, confirm that
the IDM Curl Correction option on the IDM control panel is set to Auto.

Note
For more information, refer to the Optional Devices Guide for Xerox® Versant® 3100 Press,
the Interface Decurler Module (IDM) chapter.

2. Change the Paper Curl Correction setting from the Stock Library Manager on the print
server.

Tip
Changing the default setting is considered a temporary solution because environmental
conditions vary from day to day. It is recommended that upon completion of the print job
you return the option to its default setting.

• Use thePaper Curl Correction feature to correct paper curl caused by heat and pressure,
and to apply fine adjustments based on the characteristics of each paper type. Paper
curl may cause paper jams and wrinkled output.

• This feature can be found in Stock Library Manager > Stock Properties > Advanced
Stock Setup > Paper Curl Correction
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Suggested Solutions

• From the Paper Curl Correction screen, under the type of job that is experiencing the
problem (1 Sided – Face Up, 1 Sided Face Down, or 2 Sided), select the Edit Settings
button.

• When changing the Paper Curl Correction setting, make the change by moving up or
down the available selections one at a time.

• Use the following sequential order whenmaking changes to the paper curl. This ensures
that the desired output is achieved:

Tip
Paper jams and wrinkled output may occur if the change is not performed in the recom-
mended sequential order; for example, using Default and then skipping to Type C.

Note
Always run test prints every time a setting is changed / selected; this allows you to
evaluate the output and determine if additional changes are necessary.

a. Default
b. Type A
c. Type B
d. Type C
e. Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward
f. Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward
g. Custom Curl Correction: Medium Upward or Medium Downward
h. Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward

Note
For more information, refer to Stock Library Manager Help for “Correcting Paper Curl,”
“Types A, B, and C.”

• If paper curl continues to persist after trying several or all of these settings, try decreasing
the image density on the print job or use a different type of paper.

• If paper curl is still a problem after decreasing the image density and after using a dif-
ferent type of paper, contact the Customer Support Center for further assistance.

Problem

Uneven Density / Mottle

Suggested Solutions

1. Perform Secondary Transfer Voltage Adjustment.

• Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR).
For heavy-weight paper, such as 220 g/m2 or greater, the 2nd BTR is where the image
is transferred from the belt to the paper. However there are times when it is also used
with lightweight paper.

• This feature is accessed from Stock Library Manager > Stock Properties > Advanced
Stock Setup > Secondary Transfer Voltage Adjustment.

• The Secondary Transfer Voltage Adjustment procedure can be performed by selecting
either Auto orManual.
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Suggested Solutions

Note
An automatic adjustment fixes most image quality issues. Always perform the Auto
procedure before performing theManual adjustment.

- Auto: The adjustment is done automatically by the press. It eliminates the need
for you to interpret printed targets, and manually enter adjustment values. This
saves time and avoids errors.

- Manual: The user must manually perform the adjustment, including printing test
patterns, interpreting the printed targets on those patterns, and then manually
entering the adjustment values.

Tip
Use theManual adjustment option only when the Auto adjustment does not
provide the desired output.

- For detailed information and instructions on using theAutoandManualadjustment
options, refer to Stock Library Manager Help for “Advanced Stock Setup Feature,”
“Secondary Transfer Voltage Adjustment Overview.”.

2. If the issue is observed on the tail edge of the printed output and is not corrected by per-
forming a Secondary Transfer Voltage Adjustment, change the Transfer Output Adjust-
ment for Trail Edge setting.

• Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR);
this is where the image is transferred from the belt to the paper.

• This feature is accessed from Stock Library Manager > Stock Properties > Advanced
Stock Setup > Transfer Output Adjustment for Trail Edge.

• Decrease the Transfer Output Adjustment for Trail Edge in increments of 10%. After
every incremental adjustment, run test prints and evaluate the output to determine if
additional adjustment is necessary.

3. Perform an Automatic Density Uniformity Adjustment.

Note
This is a press feature and is not a Stock Library Manager feature.

• Use this feature to correct image quality issues on the output when that image quality
is not consistent throughout the entire output. For example, the image quality is lighter
(faded) or heavier (thicker) on the left or right sides of the output (inboard / outboard).

• For information and instructions on how to use this feature, refer to Adjusting Automatic
Density Uniformity.

Problem

Image Registration, Perpendicularity, Skew, and Magnification

Suggested Solutions

1. If using trays 1, 2, or 3, try switching to tray 6 or 7 or optional tray 8 or 9 (if available).

Note
Trays 6-9 have better registration and skew performance.
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Suggested Solutions

2. Create and/or use an existing Alignment Profile.

Note
Before creating a new and/or using an existingmanual alignment, read all the information
in the Stock Library Manager Help for “Alignment Profiles.”

• Use Center Line Stock for Alignment Profiles. If the problem occurs when using this
stock, call the Customer Support Center.

• For more information, refer to the Stock Library Manager > Help > Alignment Profiles.
• The following is a summary of the steps required for each procedure; for complete in-

structions, refer to the Stock Library Manager Help for “Alignment Profiles,” “Creating /
Editing an Alignment Profile.”.

• To create a New Alignment Profile, perform the following:

a. From Stock Library Manager (on the print server), select Profiles > Alignment.
b. From the Alignment tab, select the New button.

A “New Profile Properties” window displays.

c. Enter the Name you want to assign to the profile.
d. Perform the Auto Alignment procedure.
e. Run a set of test prints to evaluate the output, and evaluate the results.
f. If necessary, depending on the results, perform aManual Adjustment.
g. When making manual adjustments to multiple items, use the following guidelines:

• Adjust the image in the following order: Registration, Perpendicularity, Skew, and
Magnification.

• Choose only one option at a time (such as Registration), then run a set of test
prints to evaluate the output. Determine if the printed output for the selected option
is acceptable and if it is acceptable, then select and adjust the next alignment op-
tion.

• After each option is selected, always run a set of test prints and evaluate the output.
Determine if the output for the selected feature is acceptable, and if it is, continue
to adjust another alignment option as required.

• To use an existing Alignment Profile, perform the following:

Note
The option may be found by selecting Stock Library Manager > Stock Properties >
Advanced Stock Setup > Alignment Profile.

a. From the Stock Properties of the desired stock, select Advanced Stock Setup > Align-
ment Profile.

b. Select either Use Default or Select from List.
If using Select from List, make a selection from the list of saved Alignment Profiles.

3. Change the Aligner Roll Pressure setting.

Tip
Changing the default setting of 0 (zero) is a temporary solution because environmental
conditions vary from day to day. Upon completion of the print job, the recommendation
is to return the option to its default setting.

• Use this feature to adjust the aligner roll pressure.
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Suggested Solutions

• Some types of coated paper slip and skew, thereby misregistering the image on the
output prints. In this case, you may need to increase the Aligner Roll Pressure to apply
more force to hold down the paper to compensate for the slippage and skewing.

• Some lightweight papers may have too much roll pressure applied to them, causing
edge damage to the output prints. In this case, you may need to decrease the roll
pressure to apply less force to hold down the paper.

• To change the Aligner Roll Pressure setting, perform the following:

a. Switch On the Pre Gate Roll Adjustment.

Important
This option must be On to allow for the custom setting of the Aligner Roll Pressure
option.

• Access the option from Stock Library Manager > Stock Properties > Advanced
Stock Setup > Pre Gate Roll Adjustment.

• Select On under the Pre Gate Roll Adjustment from the drop-down menu.

b. Adjust the Aligner Roll Pressure.

• Access the feature from Stock Library Manager > Stock Properties > Advanced
Stock Setup > Aligner Roll Pressure.

• Based on the output, increase or decrease the Aligner Roll Pressure in increments
of five or ten.

• After each incremental adjustment, run test prints and evaluate the output prints
to determine if additional adjustments are required.

4. Change the Regi-Loop setting.

Note
Use Regi-Loop only if Alignment Profile and/or Aligner Roll Pressure did not correct re-
gistration and/or skew problems.

• Use this feature to adjust Regi-Loop.
• When paper feeds through the press, it stops once and pressure is applied in order to

correct registration and skew. The loop created when paper is stopped and pressured is
Regi-Loop.

- To correct for registration and skew, and if the degree of skew varies from sheet to
sheet, increase the Regi-Loop value to increase pressure on the Lead Edge (LE) of
the paper. Increasing the value toomuchmay cause unintended folds or scratches
on the Lead Edge paper.

- In hot and humid environments, decrease theRegi-Loop value to lower the pressure
on the Lead Edge of light weight paper to avoid ripping the paper.

• This feature is accessed fromStock Library Manager > Stock Properties > Advanced
Stock Setup > Regi-Loop.

• Based on the output, increase or decrease the Regi-Loop in increments of 0.3mm. After
each incremental adjustment, run test prints and evaluate the output to determine if
additional adjustments are required.

• If feeding paper from tray 1, 2 or 3 and repeated Regi-Loop adjustments do not make
any improvements in a registration problem, return the Regi-Loop value to its default,
and adjust the Pre Gate Roll Adjustment setting. Refer to Change the Pre Gate Roll
Adjustment setting.
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Suggested Solutions

5. Change the Pre Gate Roll Adjustment setting.

• This feature is enabled onlywhen printing on paper that is 290mmor larger in landscape,
or on front and back sides of trays 1, 2, or 3, or the back sides of trays 6 - 9.

• Use this feature to adjust the behavior of the pregate roll mechanism.When paper feeds
through the press, it stops once and pressure is applied in order to correct registration
and skew. The pregate roll is one of the mechanisms that applies pressure to the paper.

• The settings available for the this feature include:

- System Default: The pregate roll setting is automatically switched according to
paper weight.

- On: To hold the paper with the pregate roll for paper weight 220 g/m² or less, select
this option only if the Regi-Loop adjustments did not correct misregistration or if
Alignment Profile did not correct image skew.

- Off: For paper weight 221 g/m² or greater where the leading edge of the paper is
torn, select this option to release the paper from the pregate roll.

Note
Selecting Off disables the Alignment Roll Pressure setting.

• After changing the setting run test prints and evaluate the output.

6. Change the Fuser Speed Adjustment setting.

• This feature is used to adjust the fusing speed to improve print quality when the image
is distorted (either stretched or shrunk).

- If the image is shrunk, increase the fuser speed. If the fuser speed is set too high,
it may cause paper jams.

- If the image is stretched, decrease the fuser speed.

• This feature is accessed from Stock Library Manager > Stock Properties > Advanced
Stock Setup > Fuser Speed Adjustment.

• Increase or decrease the fuser speed in increments of 0.1%.
• After each incremental adjustment, run test prints and evaluate the output to determine

if additional adjustments are required.

Problem

Unfused Dry Ink / Toner on Output

Suggested Solutions

1. Change the Fuser Temperature Adjustment setting.

Tip
Changing the default setting of 0 (zero) is a temporary solution because environmental
conditions vary from day to day. Upon completion of the print job, the recommendation
is to return the option to its default setting.

• User this feature to adjust the fuser temperature.
• If dry ink / toner comes off the paper, especially with special media, resolve the problem

by increasing the fusing temperature.
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Suggested Solutions

• If the fuser temperature is too high when printing on lightweight paper, it may cause
blocking, media damage, or paper jams at the peeling unit in the fusing module.

• If the fuser temperature is too low, it may cause poor fusing on higher-density image
areas and toner may peel off the printed output.

• This feature is accessed from Stock Library Manager > Stock Properties > Advanced
Stock Setup > Fuser Temperature Adjustment.

• Based on the printed output, increase or decrease the Fuser Temperature Adjustment
in increments of 1° or 2°.

• After each incremental adjustment, run test prints and evaluate the output to determine
if additional adjustments are required.

2. If feeding paper from trays 6-9 and if the paper is damp, confirm that the Enable Tray
Heater feature is Enabled (checked).

Note
Enable Tray Heater is available only for trays 6-9.

• Use this feature to Enable (checked) or Disable (unchecked) the tray heater.
• The tray heater warms the air that is blown into the tray by Tray Air Assist and helps

prevent paper jams and multifeeds by loosening contact between sheets.
• The tray heatermay partially dry paper and affect print quality. If print quality is affected

by dry paper, disable the tray heater.

Note
Disabling the tray heater may result in an increase of multifeeds.

• This feature is accessed from Stock Library Manager > Stock Properties > Advanced
Stock Setup > Enable Tray Heater.

• To Enable (check) the box for Enable Tray Heater.

Problem

Edge Damage

Suggested Solutions

Change the Aligner Roll Pressure setting.

Tip
Changing the default setting of 0 (zero) is a temporary solution because environmental condi-
tions vary from day to day. Upon completion of the print job, the recommendation is to return
the option to its default setting.

• Use this feature to adjust the aligner roll pressure.
• Some types of coated paper slip and skew, thereby misregistering the image on the output

prints. In this case, you may need to increase the Aligner Roll Pressure to apply more force
to hold down the paper to compensate for the slippage and skewing.

• Some lightweight papers may have too much roll pressure applied to them, causing edge
damage to the output prints. In this case, you may need to decrease the roll pressure to
apply less force to hold down the paper.

To change the Aligner Roll Pressure setting, perform the following:
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Suggested Solutions

1. Switch On the Pre Gate Roll Adjustment.

Important
This optionmust beOn to allow for the custom setting of theAligner Roll Pressure option.

• Access the option from Stock Library Manager > Stock Properties > Advanced Stock
Setup > Pre Gate Roll Adjustment.

• Select On under the Pre Gate Roll Adjustment from the drop-down menu.

2. Adjust the Aligner Roll Pressure.

• Access the feature from Stock Library Manager > Stock Properties > Advanced Stock
Setup > Aligner Roll Pressure.

• Based on the output, increase or decrease the Aligner Roll Pressure in increments of
five or ten.

• After each incremental adjustment, run test prints and evaluate the output prints to
determine if additional adjustments are required.

Problem

Fold Adjustment

Suggested Solutions

Tip
The Fold Adjustment Profile is available only when the system configuration includes one of
the following:

• Production Ready (PR) Booklet Maker Finisher (for Bi-Fold / Single-Fold), or
• Optional C/Z Folder with one of the following optional finishers:

- PR Finisher, or
- PR Booklet Maker Finisher, or
- PR Finisher Plus

For detailed information about these finishing devices, refer to the Optional Devices Guide for
Xerox® Versant® 3100 Press.

Create and/or use an existing Fold Adjustment Profile.

Note
Before creating a new or using an existing profile or performing any alignment adjustments,
read / review the entire Fold Adjustment Profile section in the Stock Library Manager Help.
Refer to the Stock Library Manager > Help > Fold Adjustment Profile,

• Depending on your system configuration, the following fold adjustments are available:

- Bi-Fold Single Sheet (available only with the PR Booklet Maker Finisher)
- Bi-Fold Multiple Sheets (available only with the PR Booklet Maker Finisher)
- Bi-Fold Multiple Sheets Stapled (available only with the PR Booklet Maker Finisher)
- C-Fold (available with the optional C/Z Folder)
- Z-Fold (available with the optional C/Z Folder)
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Suggested Solutions

- Z-Fold Half-Sheet (available with the optional C/Z Folder)

Create a new or use an existing Fold Adjustment Profile. The following is a summary of the
steps required for creating a new or using an existing procedure.

Note
This option is accessed from Stock Library Manager > Profiles > Fold Adjustment Profile.

1. From the Stock Library Manager main window, select Profiles.
2. Select the Fold Adjustment tab.
3. Select either the New or Edit button.

If you are editing an existing fold adjustment, select the desired profile from the list and
then select the Edit button.

4. Type in a new name, or if desired, edit the existing name.
5. To complete the procedure, refer to Stock Library Manager > Help, the Fold Adjustment

Procedures section. Select the desired fold adjustment procedure and complete the pro-
cedure for creating a new or editing an existing Fold Adjustment Profile.

Problem

Smear 208 mm from the Lead Edge

Suggested Solutions

1. Confirm the media being used is compatible with the press, is within supported specifica-
tions, and in good condition.

2. Change the Adjustment of Paper Speed at Transfer setting.

• Use this feature to adjust the paper speed in the transfer unit.
• The option can be found in Stock Library Manager > Stock Properties > Advanced

Setup > Adjustment of Paper Speed at Transfer.
• Based on the output, decrease Adjustment of Paper Speed at Transfer in increments

of 0.05%. After every increment adjustment run test prints and evaluate the output to
determine if additional adjustment is necessary.

• Transfer defects may occur when paper speed is too fast or too slow.

3. Change the Fuser Speed Adjustment setting.

• This feature can be used to correct the issue of a smear at 208 mm from the Lead Edge
(LE). Increase the fuser speed to correct the issue.

• This feature also impacts print quality.

- Increasing fuser speed extends the image. If fuser speed is set too high it may
cause paper jams.

- Decreasing fuser speed shrinks the image.

• The option can be found in Stock Library Manager > Stock Properties > Advanced
Setup > Fuser Speed Adjustment.

• Increase fuser speed in increments of 0.5%. After every increment adjustment run test
prints and evaluate the output to determine if additional adjustment is necessary.
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Problem

Trail Edge Deletions

Suggested Solutions

Change the Transfer Output Adjustment for Trail Edge setting.

• This feature is used to adjust the voltage ratio on the Secondary Bias Transfer Roll (BTR),
where the image is transferred from the belt to the paper.

• This feature can be found in Stock LibraryManager > Stock Properties > Advanced Setup >
Transfer Output Adjustment for Trail Edge.

• Decrease the Transfer Output Adjustment for Trail Edge in increments of 5 to 10%. After
every increment adjustment run test prints and evaluate the output to determine if addi-
tional adjustment is necessary.

Stock Library Manager Default Settings

The information provides the default values, ranges, and recommended incremental
adjustments for the various Stock Library Manager features, options, and settings.

Alignment Profile

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Registration

Determined by
test print output

-2.0 to 2.0 mm0.10.0Side 1, Side

Determined by
test print output

-2.0 to 2.0 mm0.10.0Side 1, Lead

Determined by
test print output

-2.0 to 2.0 mm0.10.0Side 2, Side

Determined by
test print output

-2.0 to 2.0 mm0.10.0Side 2, Lead

Perpendicularity

Determined by
test print output

-1.0 to 1.0 mm0.10.0Side 1

Determined by
test print output

-1.0 to 1.0 mm0.10.0Side 2

Skew
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Alignment Profile

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Determined by
test print output

-1.0 to 1.0 mm0.10.0Side 1

Determined by
test print output

-1.0 to 1.0 mm0.10.0Side 2

Magnification

Determined by
test print output

-0.200 to 0.200
%

0.0250.000Side 1, Height

Determined by
test print output

-0.200 to 0.200
%

0.0250.000Side 1, Width

Determined by
test print output

-0.200 to 0.200
%

0.0250.000Side 2, Height

Determined by
test print output

-0.200 to 0.200
%

0.0250.000Side 2, Width

Fold Adjustment Profile

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Bi-Fold - Single Sheet

N/AN/AN/AN/ALeft and Right
Sides Equal

Determined by
test print output

0.0 – 20.0 mm0.10.0Left Side of Fold
is Longer

Determined by
test print output

0.0 – 20.0 mm0.10.0Right Side of Fold
is Longer

Bi-Fold – Multiple Sheets Stapled

N/AN/AN/AN/ALeft and Right
Sides Equal

Determined by
test print output

0.0 – 20.0 mm0.10.0Left Side of Fold
is Longer
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Fold Adjustment Profile

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Determined by
test print output

0.0 – 20.0 mm0.10.0Right Side of Fold
is Longer

Bi-Fold – Multiple Sheets Stapled

------------Sheets in Set 1

N/AN/AN/AN/ALeft and Right
Sides Equal

Determined by
test print output

0.0 – 20.0 mm0.10.0Left Side of Fold
is Longer

Determined by
test print output

0.0 – 20.0 mm0.10.0Right Side of Fold
is Longer

N/AN/AN/AN/AOn the Fold

Determined by
test print output

0.0 – 20.0 mm0.10.0Left of Fold

Determined by
test print output

0.0 – 20.0 mm0.10.0Right of Fold

------------Sheets in Set 2

N/AN/AN/AN/ALeft and Right
Sides Equal

Determined by
test print output

0.0 – 20.0 mm0.10.0Left Side of Fold
is Longer

Determined by
test print output

0.0 – 20.0 mm0.10.0Right Side of Fold
is Longer

N/AN/AN/AN/AOn the Fold

Determined by
test print output

0.0 – 20.0 mm0.10.0Left of Fold

Determined by
test print output

0.0 – 20.0 mm0.10.0Right of Fold

C-Fold
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Fold Adjustment Profile

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Determined by
test print output

0.0 – 20.0 mm0.10.0“A” Length

Determined by
test print output

0.0 – 20.0 mm0.10.0“B” Length

Z-Fold

Determined by
test print output

0.0 – 20.0 mm0.10.0“A” Length

Determined by
test print output

0.0 – 20.0 mm0.10.0“B” Length

Z-Fold Half Sheet

Determined by
test print output

0.0 – 20.0 mm0.10.0“A” Length

Determined by
test print output

0.0 – 20.0 mm0.10.0“B” Length

Stock Properties > Advanced Stock Setup

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

---------Checked BoxStock By Name
Only

---------Checked BoxMulti Feed Detec-
tion

Primary Transfer Current Adjustment

Determined by
test print output

10 to 200 %1100Yellow

Determined by
test print output

10 to 200 %1100Magenta

Determined by
test print output

10 to 200 %1100Cyan
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Stock Properties > Advanced Stock Setup

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Determined by
test print output

10 to 200 %1100Black

Secondary Transfer Voltage Adjustment

Perform Auto Ad-
justment

10 to 300 %1150Side 1

Perform Auto Ad-
justment

10 to 300 %1150Side 2

Determined by
test print output

System Default
Multi Feed Sup-
port Table
Mis-Feed Support
Table
Forced Off
Custom1 through
8

Distinct Selec-
tions Available

System DefaultTray Air Assist

---------Checked BoxEnable TrayHeat-
er

10%0 to 100 %1100Transfer Output
Adjustment for
Trail Edge

0.05%-0.50 to 0.50 %0.010.00Adjustment of
Paper Speed at
Transfer

1° or 2 °-10 to 10° C10Fuser Temperat-
ure Adjustment

0.1%-5.0 to 5.0 %0.10.0Fuser Speed Ad-
justment

5 or 10-40 to 40 Pulse10Aligner Roll Pres-
sure

0.3 mm-3.0 to 3.0 mm0.30.0Regi-Loop

Determined by
test print output

Available selec-
tions will be
based on the Pro-
files created by
the user

Distinct Selec-
tions Available

DefaultAlignment Profile
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Stock Properties > Advanced Stock Setup

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Determined by
test print output

Available selec-
tions will be
based on the Pro-
files created by
the user

Distinct Selec-
tions Available

DefaultFold Adjustment
Profile

---System Default
On
Off

Distinct Selec-
tions Available

System DefaultPre Gate Roll Ad-
justment

Paper Curl Correction

Follow recommen-
ded sequential or-
der:

Default
Type A
Type B
Type C

Distinct Selec-
tions Available

Default1 Sided- Face Up

• DefaultCustom
• Type ASevere Upward

Medium Upward • Type B
Moderate Up-
ward

• Type C
• Custom Curl

Correction:
Slight Upward
No Curl

Slight (VerySlight Downward
Small)UpwardModerate Down-

ward or Slight (Very
Small) Down-
ward

Medium Down-
ward

• Custom Curl
Correction:

SevereDownward

Moderate
(Small) Up-
wardorModer-
ate (Small)
Downward

• Custom Curl
Correction:
Medium Up-
ward or Medi-
umDownward

• Custom Curl
Correction:
Severe (Large)
Upward or
Severe (Large)
Downward
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Stock Properties > Advanced Stock Setup

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Follow recommen-
ded sequential or-
der:

Default
Type A
Type B
Type C

Distinct Selec-
tions Available

Default1 Sided- Face
Down

• DefaultCustom
• Type ASevere Upward

Medium Upward • Type B
Moderate Up-
ward

• Type C
• Custom Curl

Correction:
Slight Upward
No Curl

Slight (VerySlight Downward
Small)UpwardModerate Down-

ward or Slight (Very
Small) Down-
ward

Medium Down-
ward

• Custom Curl
Correction:

SevereDownward

Moderate
(Small) Up-
wardorModer-
ate (Small)
Downward

• Custom Curl
Correction:
Medium Up-
ward or Medi-
umDownward

• Custom Curl
Correction:
Severe (Large)
Upward or
Severe (Large)
Downward

Follow recommen-
ded sequential or-
der:

Default
Type A
Type B
Type C

Distinct Selec-
tions Available

Default2 Sided

• DefaultCustom
• Type ASevere Upward

Medium Upward • Type B
Moderate Up-
ward

• Type C
• Custom Curl

Correction:
Slight Upward
No Curl

Slight (VerySlight Downward
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Stock Properties > Advanced Stock Setup

Recommended
Incremental Ad-
justment

Available RangeAdjustment Step
Increments

Default ValueOption / Setting

Moderate Down-
ward

Small)Upward
or Slight (Very

Medium Down-
ward

Small) Down-
ward

SevereDownward • Custom Curl
Correction:
Moderate
(Small) Up-
wardorModer-
ate (Small)
Downward

• Custom Curl
Correction:
Medium Up-
ward or Medi-
umDownward

• Custom Curl
Correction:
Severe (Large)
Upward or
Severe (Large)
Downward

Paper Jams
If a paper jam occurs, a fault screen displays a message on the press control panel
indicating in which area the jam is situated. Follow the instructions provided for clearing
the jam and resuming press operation.

For more information, refer to Fault Messages.

Paper Jam Information

Before clearing paper jams, always refer to Fault Information.

Warning
When removing jammed paper, make sure that no pieces of jammed paper are left in
the press. A piece of paper remaining in the press can cause fire. If a piece of paper is
stuck in a hidden area or paper is wrapped around the fuser unit or rollers, do not remove
it forcefully. You can get injured or burned. Switch off the press immediately and contact
the Customer Support Center.
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Paper Jams Inside the Press

There are three main module areas of the press where paper jams may occur:

• The Registration area behind the Left Front Door (Xerographic Drawer, Transfer
Drawer, and Paper Handling Drawer)

• Fuser Assembly and Decurler area behind the Center Front Door
• Inverter and Entrance / Exit areas of the Output / Cooling Module behind the Right

Front Door

Tip
Always check the OutputModule first for a paper jamat the entrance of themodule.
Rotate the green knobs to pull paper through the entrance areas completely. Always
ensure that all paper jams, including any small ripped pieces of paper, are cleared before
proceeding with your print job.

Warning
Never touch a labeled area indicating High Temperature and Caution; this area is found
on the fuser unit or nearby. Contact to this area can lead to burns.

Clearing Jams in Area 2
Important
Before opening any press doors, ensure that the press has stopped printing.

The transfer drawer includes the following jam clearance areas:

• Registration and alignment transport
• Registration roll
• Duplex transport
• Fuser entrance

1. Open the left and center front doors.
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2. To unlock transfer drawer, locate the green handle 2 and rotate it clockwise (right)
to the horizontal position.

3. Slowly pull out the transfer drawer until it stops.

Note
If paper is jammed in the drawer while pulling it out, stop pulling when the jammed
paper is visible. Hold down the paper with one hand, and then continue pulling out
the drawer.

4. If paper is jammed at the top of the transfer drawer, remove paper from area 2a by
pulling it straight out.

5. Open lever 2b upward and any remove jammed paper.
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6. Return lever 2b to its original position.

7. Locate area 2c and pull any jammed paper out towards the left.

8. Open lever 2d upward and lever 2e to the right ; remove any jammed paper
.

9. Return levers 2d and 2e to their original position.
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10. Open lever 2f lever downward and remove any jammed paper.

11. Return lever 2f to its original position.

12. To close the transfer drawer, grasp handle 2 and gently push in the drawer completely
; turn the green handle to the left to lock the drawer in place .

13. Close the left and center front doors completely. The press does not operate when
doors or covers are open.

Clearing Jams in Areas 3, 4 and 5
Important
Before opening any press doors, ensure that the press has stopped printing.
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1. Open the right front door.

2. Open lever 3a upward , and remove any jammed paper .

3. If there is difficulty in removing the jammed paper, rotate knob 3b clockwise (right)
, and remove the jammed paper .

Note
There may be extra sheets remaining in the press. To ensure all sheets are removed,
rotate knob 3b clockwise (right) three times.

4. Return lever 3a to its original position.
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5. Open lever 5a downward , and remove any jammed paper .

6. If there is difficulty in removing the jammed paper, rotate knob 5b clockwise (right)
, and remove the jammed paper .

7. Return lever 5a to its original position.

8. Open lever 5c downward , and remove any jammed paper .
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9. If there is difficulty in removing the jammed paper, rotate knob 5d clockwise (right)
, and remove the jammed paper .

10. Return lever 5c to its original position.

11. To open the exit module drawer, grasp handle 4 and rotate handle to the right to
the horizontal position.

12. Slowly pull out the exit module drawer until stops.
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13. Remove any jammed paper from the top of themodule (area 4a) by pulling it straight
out.

14. If there is difficulty in removing the jammed paper, rotate knob 4a clockwise (right)
, and remove the jammed paper .

15. Open lever 4b to the right , and remove any jammed paper .

16. If there is difficulty in removing the jammed paper, open lever 4d to the right ,
and remove the jammed paper .
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17. Return levers 4b and 4d to their original positions.

18. Open lever 4c to the right , and remove any jammed paper .

19. Return lever 4c to its original position.

20.
21. To close the exit module, grasp handle 4, gently push in the exit module completely

, and rotate handle to the left to lock the module in place .

22. Close the right front door completely. The press will not operate if a door is open even
slightly.
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Paper Jams in Trays 1-3
Note
Paper is sometimes torn and remains inside the press if you open a traywithout checking
the paper jam position. This may cause a malfunction. Check where the paper jam
occurred before clearing the problem.

1. Open the tray where the paper jam occurred.

2. Remove the jammed paper.

3. Push the tray in gently until it comes to a stop.

Paper Jams in the Bypass (Tray 5)
Paper Jams When the Bypass is Installed on Trays 6 and 7
Tip
Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared
before proceeding with any print jobs.

1. Remove the paper currently loaded in the Bypass (Tray 5).
2. Lift and open the Top Cover of the Bypass (Tray 5).
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3. Remove any jammed paper.

Note
If paper is torn, check inside the press and remove it.

4. Close the Top Cover of the Bypass (Tray 5).

5. Reload paper into the tray and resume printing.

OHCF Jam Clearance (Trays 6 and 7)
Clearing OHCF Jams (Trays 6 and 7)

Nip Release levers inside of the Transport area of the Feeder hold back large size sheets
(such as A3, 11 x 17 inches, 12 x 18 inches) to reduce the chance of jamming as paper
enters the print engine.

Note
Follow the jam clearance instructions displayed on the touch screen. Always ensure that
all paper jams, including any small ripped pieces of paper, are cleared before proceeding
with your print jobs.

Paper Jams inside OHCF Trays 6 and 7
1. Pull out the tray where the paper jam occurred.
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2. Remove the jammed paper.

Note
If paper is torn, check inside the machine and remove it.

3. Gently push in the tray until it comes to a stop.

OHCF (Trays 6 and 7) Paper Jams at Lever 1a and Knob 1c
1. Open the front cover of the feeder module.

2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed
paper.

Note
If paper is torn, check inside the machine and remove it.

3. Return the lever 1a to the original position.

4. Close the front cover of the feeder module.

Note
If the front cover of the feedermodule is not completely closed, amessagewill appear
and the machine will not operate.
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OHCF (Trays 6 and 7) Paper Jams at Lever 1b and Knob 1c
1. Open the front cover of the feeder module.

2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed
paper.

Note
If paper is torn, check inside the machine and remove it.

3. Return the lever 1b to the original position.

4. Close the front cover of the feeder module.

Note
If the front cover of the feedermodule is not completely closed, amessagewill appear
and the machine will not operate.

OHCF (Trays 6 and 7) Paper Jams at Lever 1d and Knob 1c
1. Open the front cover of the feeder module.
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2. Move the lever 1d upward and remove the jammed paper.

Note
If paper is torn, check inside the machine and remove it.

3. If the paper cannot be removed, turn the knob 1c clockwise, and then remove the
jammed paper.

Note
If paper is torn, check inside the machine and remove it.

4. Return the lever 1d to the original position.

5. Close the front cover of the feeder module.

Note
If the front cover of the feedermodule is not completely closed, amessagewill appear
and the machine will not operate.

Fault Information
The following occurs when there is an fault, such as paper jams, open doors or covers,
or a press malfunction:

• The press stops running and an fault message displays on the press touch screen.
• The message includes a graphical illustration showing the location of the fault along

with a brief explanation of corrective actions for clearing the fault.
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• Paper jams may occur in multiple areas of the press and any optional devices
connected to the press. When this happens, the graphical illustration changes to
show the multiple locations and the required corrective actions.

• Additionally, if a fault occurs with an optional device, an indicator lights on that
device's control panel and shows the corresponding area on the device where the
fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.
• Paper jams can be removedwith the press still powered on.When the power is turned

off, all information stored to the system's memory will be erased.
• Clear all paper jams before resuming print jobs.
• Do not touch components inside the press. This can cause print defects.
• Ensure that all paper jams, including any small ripped pieces of paper, are cleared

before proceeding with print jobs.
• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove

all torn pieces.
• After removing paper jams, close all doors and covers. The press cannot print when

doors or covers are open.
• After clearing a paper jam, printing automatically resumes from the state before the

paper jam occurred.
• If all paper jams are not cleared, an error message continues to display on the press

touch screen. To clear any remaining jams, refer to the press touch screen for
instructions and information.

Obtaining Fault Information from the Press Touch Screen
When an fault occurs, such as paper jams, open doors or covers, or a press malfunction,
the press stops printing, and a message appears on the press touch screen. Use the
following procedure to obtain information and instructions about the correcting the
fault.
1. From Home on the press touch screen, select the Faults button.

• If there is only one fault, a Fault screen displays.
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• If there are multiple faults, a list displays underneath the graphical illustration
on the Home screen; refer to the illustration in the next step.

2. Select the first, top item from the displayed list.

Note
Multiple faults are listed in descending order with the top fault being number one.
Correct them in the order they listed starting with the top one and working down the
list.

A Fault screen displays.
3. To correct a fault, following the instructions provided on the Fault screen.

When finished, select Close.

4. Repeat the previous steps until all faults are cleared.
If a fault cannot be cleared, contact the system administrator.

Fault Messages

When an fault occurs, such as paper jams, open doors or covers, or a press malfunction,
the press stops printing, and a message appears on the press touch screen. A graphical
illustration shows the location of the fault with a brief explanation of corrective actions
for clearing the fault. If a fault occurs inmore than one location, the illustration changes
to indicate the multiple locations and the required corrective actions.
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Note
For more information, refer to Obtaining Fault Information from the Press Touch Screen.

Detailed information and instructions about the correcting a fault is available by selecting
the Faults button on the Home screen. The Fault screen displays.

Find the code for the fault listed at the bottom of the Fault screen.

Troubleshooting Help

Locating the Press Serial Number

The press serial number can be accessed fromeither the press control panel or by locating
the serial number plate on the inside frame of the first feeder tray (Tray 1).
1. Press theMachine Status button on the press control panel.
2. From the Machine Status screen, ensure that theMachine Information tab is

displayed.
The press serial number is displayed under General Information.

3. If there is a loss of power and it is not possible to access theMachine Status screen,
the press serial number can also be found on the inside frame of the press near paper
Tray 1:
a) At the press, fully open paper Tray 1.
b) At the left of the feeder tray, on the press frame, locate the plate with the serial

number (SER#).

Calling for Service
1. Record any displayed fault codes.

For more information, refer to Faults Tab and Fault Messages.

2. Record the press serial number.
a) Select theMachine Status button at the press control panel.
b) From the Machine Status screen, select theMachine Information tab.
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The serial number is listed with the Machine Information.
c) If the serial number is not displayed, open Tray 1 and locate the serial number

plate on the left side of the frame (SER #).
For more information, refer to Locating the Press Serial Number.

3. If output quality is a problem, take a sample as a reference to assist you in describing
the problem over the telephone when answering the questions from the customer
support operator about the defects.

4. If possible, use a phone near the press when calling for assistance. Follow the
instructions provided by the operator.

5. For system support, user help, and service support, call the appropriate number.
For the specific number in your area, go to www.xerox.com and select the Support
link.
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Specifications

DescriptionFeature

100 pages per minute of Letter (8.5 x 11 in.) / A4 paper size (full color
or black only)

Rated Speed

Two print modes are supported and are specified at the print server:Print Modes

• 4 Color Mode: Cyan, Magenta, Yellow, Black (CMYK)
• Black and White Mode (Grayscale)

MaximumPrintableArea
• Default Border: 2 mm on all sides
• Adjustable Border: 0.5 mm up to 400 mm on all sides
• Print Image Quality Assurance Area: 12.48 x 18.98 in. / 317 mm

x 482 mm
• For Trays 1, 2 or 3: 12.72 x 18.98 in. / 323 x 482 mm
• Tray 5 (Bypass): 12.83 x 18.98 in. / 326 x 482 mm
• Advanced High Capacity Feeder (Trays 6 and 7): 12.83 x 18.98 in.

/ 326 x 482 mm

Printing Resolution
• Print Engine Imaging Resolution: 2400 x 2400 dots-per-inch (dpi)
• Print Server Raster-Image-Processing (RIP) Resolution (print server

to print engine): 1200 x 1200 dpi

For information, refer to Paper Size Ranges.Paper Size Ranges

For information, refer to Paper Tray Information.Paper Tray Information

For information, refer to Press Productivity Information.Productivity Information
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Performance Specifications

DescriptionFeature

The press warmup times vary depending on the current state / mode
of the press. Warmup times are listed as follows:

Press Warmup Time

• Froma cold start (either power on or power savermode), less than
5 minutes

• From Sleep Mode / Power Saver, less than 5 minutes
• From Standby Mode, less than 1 minute
• When switching printmodes (such as fromblack only to full color),

approximately 2 minutes

This is the minimum time from when the press receives a job from
the print server to the timewhen the trail edge of the first print passes
through the press exit sensor.

Time of First Print Out of
Press

• From a cold start (power on or power saver), the system takes less
than 5 minutes to start printing

• From standby mode, the system usually takes less than 1 minute
to the start printing

Environmental Specifications
The press enters the Power Saver mode after fifteen minutes of inactivity. The factory
default time of fifteen minutes can be changed when logged on as the administrator.
For more information, refer to the System Administration Guide.

The temperature and relative humidity of the room where the press is located must be
within the minimum and maximum allowable temperature and relative humidity limits
for the press system to operate correctly.

PressOperating Environment

50° to 90° F (10° to 32° C)Required Temperature Range

15% to 85% Relative Humidity (RH)Required Relative Humidity

Max of 8,200 ft. (2,500 meters)Altitude(above sea level)

Sound Pressure Levels
• Running: 65 dBA (decibels (Acoustics))
• Standby: 40.8 dBA
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